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Introduction

This guide describes the Pipe Flow Module, an optional add-on package for
COMSOL Multiphysics® designed to model and simulate incompressible and
weakly compressible flow, heat and mass transfer in pipes and channels with the
Pipe Flow features. Compressible hydraulic transients and acoustics waves can also
be modeled using the Water Hammer features and Pipe Acoustics features,
respectively. The Pipe Flow module can address problems involving flow velocity,
pressure, temperature and sound waves in cooling systems, ventilation systems, pipe

systems in the chemical processing industry, and lines in the oil and gas industry.

This chapter introduces you to the capabilities of this module. A summary of the
physics interfaces and where you can find documentation and model examples is
also included. The last section is a brief overview with links to each chapter in this

guide.



About the Pipe Flow Module

What Can the Pipe Flow Module Do?

The Pipe Flow Module is intended for the modeling and simulation of flow of fluids
in pipes and channel systems, as well as compressible hydraulic transients and acoustics
waves. Typical simulations yield the velocity, pressure variation, and temperature in

systems of pipes and channels. Hydraulic transients resulting from a valve that is closed
rapidly in a pipe network is referred to as water hammer, which can be modeled too.
The module can be used to design and optimize complex cooling systems in turbines,
ventilation systems in buildings, pipe systems in chemical processes, and lines in the oil

and gas industry.

In common for pipes and channels that can be modeled using the Pipe Flow Module
is that the pipe length is large enough so that the flow inside can be considered fully
developed. Piping components such as bends, valves, T-junctions, contractions/

expansions and pumps are also available in the module.
The module includes these physics interfaces:

e The Pipe Flow interface computes the pressure and velocity field in isothermal pipe

systems.

* The Heat Transfer in Pipes interface computes the energy balance in pipe systems
but receives the flow field as a value or as a known solved field. Wall heat transfer to

the surroundings is included.

e The Transport of Diluted Species in Pipesinterface solves a mass balance equation
for pipes in order to compute the concentration distribution of a solute in a dilute

solution, considering diffusion, dispersion, convection, and chemical reactions.

e The Nonisothermal Pipe Flow interface is a multiphysics interface that solves the

flow, pressure, and temperature simultaneously and fully coupled.

e The Reacting Pipe Flow interface is a multiphysics interface that solves the flow,
pressure, temperature, and reacting species transport simultaneously and fully

coupled.

e The Water Hammer interface solves rapid hydraulic transients in pipe systems,

taking the elastic properties of both the fluid and pipe wall into account.

8 | CHAPTER |: INTRODUCTION



* The Pipe Acoustics, Frequency Domain interface models sound waves in flexible

pipe systems, with the assumption of harmonic vibrations.

e The Pipe Acoustics, Transient interface models sound waves in flexible pipe systems

with arbitrary transient variations in pressure.

The physics interfaces in the module define the conservation of momentum, energy,
and mass of a fluid inside a pipe or channel system. The flow, pressure, temperature,
and concentration fields across the pipe cross sections are modeled as cross-section
averaged quantities, which only vary along the length of the pipes and channels. The
pressure losses along the length of a pipe or in a pipe component are described using
friction factor expressions. A broad range of built-in expressions for Darcy friction
factors cover the entire flow regime from laminar to turbulent flow, Newtonian and
non-Newtonian fluids, different cross-sectional geometries, and a wide range of
relative surface roughness values. In addition to the continuous frictional pressure
drop along pipe stretches, pressure drops due to momentum changes in components
such as bends, contractions, expansions, T-junctions and valves are computed through
an extensive library of industry standard loss coefficients. Pumps are also available as

components.

Building a COMSOL Multiphysics Model in the COMSOL Multiphysics
Gl- Reference Manual

The Pipe Flow Module Physics Interface Guide

The Pipe Flow Module extends the functionality of the physics interfaces of the base
package for COMSOL Multiphysics. The details of the physics interfaces and study
types for the Pipe Flow Module are listed in the table. The functionality of the
COMSOL Multiphysics base package is given in the COMSOL Multiphysics
Reference Manual.

In the COMSOL Multiphysics Reference Manual:
* Studies and Solvers
Gl, e The Physics Interfaces
* For a list of all the core physics interfaces included with a COMSOL

Multiphysics license, see Physics Interface Guide.

ABOUT THE PIPE FLOW MODULE
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PHYSICS INTERFACE ICON |[TAG SPACE AVAILABLE PRESET STUDY
DIMENSION TYPE
1)) Acoustics
)= Acoustic-Structure Interaction
Pipe Acoustics, ]| pafd 3D, 2D eigenfrequency; frequency
Frequency Domain ! domain
Pipe Acoustics, (B |patd 3D, 2D time dependent
Transient
¢:: Chemical Species Transport
Reacting Pipe Flow S (rpfl 3D, 2D stationary; time dependent
Transport of Diluted Sy |dsp 3D, 2D stationary; time dependent
Species in Pipes
== Fluid Flow
== Single-Phase Flow
Pipe Flow S |pfl 3D, 2D stationary; time dependent
Woater Hammer el whtd 3D, 2D time dependent
—= Nonisothermal Flow
Nonisothermal Pipe X nipfl 3D, 2D stationary; time dependent
Flow
Heat Transfer
Heat Transfer in Pipes htp 3D, 2D stationary; time dependent

1 Requires both the Pipe Flow Module and the Acoustics Module.

CHAPTER |I: INTRODUCTION




Common Physics Interface and Feature Settings and Nodes

There are several common settings and sections available for the physics interfaces and
feature nodes. Some of these sections also have similar settings or are implemented in
the same way no matter the physics interface or feature being used. There are also some
physics feature nodes that display in COMSOL Multiphysics.

In each module’s documentation, only unique or extra information is included;
standard information and procedures are centralized in the COMSOL Multiphysics
Reference Manual.

In the COMSOL Multiphysics Reference Manual see Table 2-3 for
links to common sections and Table 2-4 to common feature nodes.
n You can also search for information: press F1 to open the Help

window or Ctrl+F1 to open the Documentation window.

The Liquids and Gases Materials Database

The Pipe Flow Module includes an additional Liquids and Gases material database with
temperature-dependent fluid dynamic and thermal properties.

For detailed information about materials and the Liquids and Gases
A Materials Database, see Materials in the COMSOL Multiphysics
Reference Manual.

Where Do I Access the Documentation and Application Libraries?

A number of internet resources have more information about COMSOL, including
licensing and technical information. The electronic documentation, topic-based (or

ABOUT THE PIPE FLOW MODULE
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context-based) help, and the application libraries are all accessed through the
COMSOL Desktop.

Ifyou are reading the documentation as a PDF file on your computer,
the blue links do not work to open an application or content
referenced in a different guide. However, if you are using the Help

n system in COMSOL Multiphysics, these links work to open other
modules (as long as you have a license), application examples, and
documentation sets.

THE DOCUMENTATION AND ONLINE HELP

The COMSOL Multiphysics Reference Manual describes the core physics interfaces
and functionality included with the COMSOL Multiphysics license. This book also has
instructions about how to use COMSOL Multiphysics and how to access the
electronic Documentation and Help content.

Opening Topic-Based Help

The Help window is useful as it is connected to many of the features on the GUI. To
learn more about a node in the Model Builder, or a window on the Desktop, click to
highlight a node or window, then press F1 to open the Help window, which then
displays information about that feature (or click a node in the Model Builder followed
by the Help button ( [§ ). This is called topic-based (or context) help.

To open the Help window:
¢ In the Model Builder, Application Builder, or Physics Builder click a node or
window and then press F1.

* On any toolbar (for example, Home, Definitions, or Geometry), hover the
Win mouse over a button (for example, Add Physics or Build All) and then

press F1.
* From the File menu, click Help ( E )-

* Inthe upper-right corner of the COMSOL Desktop, click the Help ( & )
button.

CHAPTER 1I:

INTRODUCTION



To open the Help window:

¢ In the Model Builder or Physics Builder click a node or window and then
press F1.

¢ On the main toolbar, click the Help ( [gJ ) button.

e From the main menu, select Help>Help.

Opening the Documentation Window

To open the Documentation window:

Win e Press Ctrl+F1.

¢ From the File menu select Help>Documentation ( I! ).

To open the Documentation window:

e Press Ctrl+F1.

* On the main toolbar, click the Documentation ( |[Jjf ) button.
Linux

¢ From the main menu, select Help>Documentation.

THE APPLICATION LIBRARIES WINDOW

Each application includes documentation with the theoretical background and
step-by-step instructions to create a model application. The applications are available
in COMSOL as MPH-files that you can open for further investigation. You can use the
step-by-step instructions and the actual applications as a template for your own
modeling and applications. In most models, SI units are used to describe the relevant
properties, parameters, and dimensions in most examples, but other unit systems are

available.

Once the Application Libraries window is opened, you can search by name or browse
under a module folder name. Click to view a summary of the application and its

properties, including options to open it or a PDF document.

The Application Libraries Window in the COMSOL Multiphysics
E}‘ Reference Manual.

ABOUT THE PIPE FLOW MODULE



Opening the Application Libraries Window
To open the Application Libraries window ( ﬂ]]] ):

* From the Home toolbar, Windows menu, click ([f[]] ) Applications
Libraries.

Win ¢ From the File menu select Application Libraries.

To include the latest versions of model examples, from the File>Help
menu, select (5]] ) Update COMSOL Application Library.

To include the latest versions of model examples, from the Help menu

Select Application Libraries from the main File> or Windows> menus.

Linux select (7] ) Update COMSOL Application Library.

CONTACTING COMSOL BY EMAIL

For general product information, contact COMSOL at info@comsol.com.

To receive technical support from COMSOL for the COMSOL products, please
contact your local COMSOL representative or send your questions to
support@comsol.com. An automatic notification and a case number are sent to you by
email.

COMSOL ONLINE RESOURCES

COMSOL website www.comsol.com

Contact COMSOL www.comsol.com/contact

Support Center www.comsol.com/support

Product Download www.comsol.com /product-download
Product Updates www.comsol.com/support,/updates
COMSOL Blog www.comsol.com/blogs

Discussion Forum www.comsol.com/community

Events www.comsol.com/events

COMSOL Video Gallery www.comsol.com /video

Support Knowledge Base www.comsol.com/support/knowledgebase
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Overview of the User’s Guide

The Pipe Flow Module User’s Guide gets you started with modeling using COMSOL
Multiphysics. The information in this guide is specific to this module. Instructions how
to use COMSOL in general are included with the COMSOL Multiphysics Reference
Manual.

As detailed in the section Where Do I Access the Documentation and
Application Libraries? this information can also be searched from the
COMSOL Multiphysics software Help menu.

TABLE OF CONTENTS AND INDEX
To help you navigate through this guide, see the Contents and Index.

THE FLUID FLOW BRANCH
Fluid Flow Interfaces chapter describes the Pipe Flow interface and the Nonisothermal
Pipe Flow interface including the underlying theory for these physics interfaces.

THE HEAT TRANSFER BRANCH
Heat Transfer Interfaces chapter describes the Heat Transfer in s interface and the
underlying theory for the physics interface.

THE CHEMICAL SPECIES TRANSPORT BRANCH
Chemical Species Transport Interfaces chapter describes the Transport of Diluted
Species in s and the Reacting Pipe Flow interfaces and the underlying theory.

THE ACOUSTICS BRANCH
Acoustics Interfaces chapter describes the Pipe Acoustics, Transient interface and its

theory. This physics interface requires both the Acoustics Module and the Pipe Flow
Module.

OVERVIEW OF THE USER’S GUIDE | |5
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Fluid Flow Interfaces

This chapter has information about the physics interfaces in the Pipe Flow Module
found under the Fluid Flow branch (=.).

Mechanisms for Modeling Fluid Flow
The Pipe Flow Interface

The Nonisothermal Pipe Flow Interface
The Water Hammer Interface

Theory for the Pipe Flow Interface

Theory for the Water Hammer Interface

See The Single-Phase Flow, Laminar Flow Interface in the COMSOL Multiphysics
Reference Manual for other Fluid Flow interface and feature node settings.
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CHAPTER 2:

Mechanisms for Modeling Fluid Flow

The Fluid Flow branch (= )has a number of subbranches to describe momentum
transport. The main focus of this physics area is to model fluids transported in pipe
networks in 2D and 3D space, calculating velocity, flow rate, and pressure drops. Pipe
flow including heat and mass transfer can also be modeled.

The Pipe Flow Interface (5g.), found under the Single-Phase Flow branch (=) when
adding a physics interface, is used to model incompressible and weakly compressible

fluid flow in piping systems. The equations that are solved are 1D equations that live
on 2D boundary segments or 3D edge segments.

The Nonisothermal Pipe Flow Interface (5g.), found under the Nonisothermal Flow
branch (=) when adding a physics interface, solves a temperature equation together

with the equations for compressible flow.

The Water Hammer Interface ()(0) ), found under the Fluid Flow>Single-Phase Flow
branch (=) when adding a physics interface, has the equations and boundary

conditions for modeling rapid pressure transients in a pipe systems.

Coupling to Other Physics Interfaces

Itis often be relevant to couple flow and transport in pipes or pipe networks to physical
processes occurring outside the pipe network itself. For instance, liquid can be injected
into the surrounding by means of perforated pipes. The Pipe Flow interface can

calculate flow rates and pressure drops in a 1D representation in the injection system.
The equations can then be coupled to a Fluid Flow interface describing fluid flow in
2D or 3D geometries. Another important coupling that is prepared in the Pipe Flow
module is the Wall Heat Transfer feature that couples the temperature in a pipe to the

temperature in a 3D surrounding.

More advanced descriptions 2D and 3D continuum fluid flow, such as turbulent and
multiphase flow, can be found in the CFD Module. More extensive descriptions of heat
transfer, such as in turbulent flow or involving radiation, can be found in the Heat
Transfer Module. Furthermore, some applications involving the flow of liquids and
gases in porous media are better handled by the Chemical Reaction Engineering
Module.

FLUID FLOW INTERFACES



The Pipe Flow Interface

The Pipe Flow (pfl) interface (5g.)

when adding a physics interface, is used to compute the velocity and pressure fields in

, found under the Single-Phase Flow branch (=)

pipes and channels of different shapes. It approximates the pipe flow profiles flow by
1D assumptions in curve segments, or lines. These lines can be drawn in 2D or 3D and
represent simplifications of hollow tubes. The interface is available in 3D on edges, and

in 2D on boundaries.

When this physics interface is added, these default nodes are also added to the Model
Builder — Fluid Properties, Pipe Properties, Pressure, Lossless Fitting and Initial Values.
Then, from the Physics toolbar, add other nodes that implement, for example,
boundary conditions and volume forces. You can also right-click Pipe Flow to select

physics features from the context menu.

SETTINGS

The Label is the default physics interface name.

The Name is used primarily as a scope prefix for variables defined by the physics
interface. Refer to such physics interface variables in expressions using the pattern
<name>.<variable_name>. In order to distinguish between variables belonging to
different physics interfaces, the name string must be unique. Only letters, numbers, and

underscores (_) are permitted in the Name field. The first character must be a letter.
The default Name (for the first physics interface in the model) is pf1.

FLUID MODEL

Select a Fluid model — Newtonian (the default), Power Law, or Bingham.

For Newtonian sclect Single phase (the default), Gas-Liquid, friction factor multiplier, or

Gas-Liquid, effective Reynolds number.

When Gas-Liquid, friction factor multiplier or Gas-Liquid, effective Reynolds number arc
selected, the Phase Fractions node is automatically added as a default node. Selecting
these options also enables the choice of Liquid material and Gas material for the Fluid

Properties node.

For more information about the fluid models, see the section Theory for the Pipe Flow
Interface.

THE PIPE FLOW INTERFACE
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DEPENDENT VARIABLES
This section defines the dependent variables (fields). If required, edit the name, but

dependent variables must be unique within a model:

* Pressure p (SI unit: Pa)

¢ Tangential velocity u (SI unit: m/s)

DISCRETIZATION

To display this section, click the Show button ("& ) and select Discretization.

The Value type when using splitting of complex variables sctting should in most transport
problems be set to Real which is the default. It makes sure that the dependent variable
does not get affected by small imaginary contributions, which can occur, for example,
when combining a Time Dependent or Stationary study with a frequency-domain
study. For more information, see Splitting Complex-Valued Variables in the COMSOL
Multiphysics Reference Manual.

FURTHER READING

* For an explanation of the tangential velocity, see Theory for the Pipe

Flow Interface.
a * Edge, Boundary, Point, and Pair Nodes for the Pipe Flow Interface

* Theory for the Pipe Flow Interface

* Discharging Tank: Application Library path Pipe_Flow_Module/
Tutorials/discharging_tank

Convective Flow in o Heat Exchanger Plate: Application Library path
Pipe_Flow_Module/Heat_Transfer/heat_exchanger_plate

CHAPTER 2:

Edge, Boundary, Point, and Pair Nodes for the Pipe Flow Interface

The Pipe Flow Interface has these boundary, edge, point, and pair nodes, listed in

alphabetical order, available from the Physics ribbon toolbar (Windows users), Physics

FLUID FLOW INTERFACES



context menu (Mac or Linux users), or right-click to access the context menu (all

users).
In general, to add a node, go to the Physics toolbar, no matter what
m operating system you are using. Subnodes are available by clicking the
? parent node and selecting it from the Attributes menu.
¢ Bend e Pipe Connection
* Contraction / Expansion * Pipe Properties
* Fluid Properties * Pressure
¢ Initial Values e Pump
e Inlet e T-Junction
* Internal Pressure Lock * Valve
* No Flow * Volume Force
¢ n-Way Junction ¢ Y-Junction
* Outlet * Lossless Fitting

¢ Phase Fractions

In the COMSOL Multiphysics Refevence Manual see Table 2-3 for links
to common sections and Table 2-4 to common feature nodes. You can
n also search for information: press F1 to open the Help window or Ctrl+F1

to open the Documentation window.

Fluid Properties

The Fluid Properties node is always present and adds the momentum and mass balance
equations solved by the physics interface. If volume forces are needed in the model,
they should be added by a Volume Force node. The node also provides settings for
defining the material properties of the fluid. If a Liquid-Gas option is selected in the
Pipe Flow node settings, properties for both liquid and gas can be entered here.

FLUID PROPERTIES
This subsection displays when Newtonian>Single phase is selected as the Fluid model for
the Pipe Flow interface.

THE PIPE FLOW INTERFACE
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CHAPTER 2:

The default Density o (SI unit: l(g/ms) uses the value From material. For User defined

enter a different value or expression.

The default Dynamic viscosity £ (SI unit: Pa-s) uses the value From material and
describes the relationship between the shear rate and shear stresses in a fluid.
Intuitively, water and air have a low viscosity, and substances often described as thick

(such as oil) have a higher viscosity.

LIQUID PROPERTIES
This section displays when Newtonian is selected as the Fluid model for the Pipe Flow
interface and then Gas-Liquid, friction factor multiplier or Gas-Liquid, effective Reynolds

number are also chosen.

Select the Liquid material—Edge material (3D components) or Boundary material (2D
components). If you have more than one material added to the model, you can toggle

this setting between the different designated materials.

The default Density o, (SI unit: kg/mg) uses the value From material. You can change
this to User defined to enter a different value or expression.

The default Dynamic viscosity g, (SI unit: Pa-s) uses the value From material and
describes the relationship between the shear rate and shear stresses in a fluid.
Intuitively, water and air have a low viscosity, and substances often described as thick

(such as oil) have a higher viscosity.

GAS PROPERTIES
This section displays when Newtonian is selected as the Fluid model for the Pipe Flow
interface and then Gas-Liquid, friction factor multiplier or Gas-Liquid, effective Reynolds

number are also chosen.

Select the Gas material—Edge material (3D components) or Boundary material (2D
components). If you have more than one material added to the model, you can toggle

this setting between the different designated materials.

The default Density pg (SI unit: kg/ms) uses the value From material. For User defined

enter a different value or expression.

The default Dynamic viscosity fg (SI unit: Pa-s) uses the value From material and

describes the relationship between the shear rate and shear stresses in a fluid.

FLUID FLOW INTERFACES



MIXTURE VISCOSITY MODEL
This section displays only when Newtonian is selected as the Fluid model for the Pipe

Flow interface and the Gas-Liquid, effective Reynolds number is also chosen.

The default is the Extended Einstein which is considered the most accurate method for
a large range of gas fractions. The list of options include

* Extended Einstein (default)

e Linear average

* Reciprocal average

* Liquid viscosity

¢ User defined

For details, please refer to the theory section Newtonian Fluids.

Volume Force

The Volume Force node specifies the volume force F on the right-hand side of the flow

equation. Use it, for example, to incorporate the effects of gravity in a model.

If several volume force nodes are added to the same domain, then the sum of all
contributions are added to the momentum equations.

VOLUME FORCE
Enter the components of the Volume force F (SI unit: N/ms).
Pipe Properties

The Pipe Properties node is used to define the pipe shape, flow resistance, and surface

roughness.

THE PIPE FLOW INTERFACE
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CHAPTER 2:

PIPE SHAPE
Select a pipe shape from the list — Not set (the default), Circular, Square, Rectangular,

or User defined.

¢ For Circular enter a value or expression for the Inner diameter d; (SI unit: m). The
default is 10 cm.

* For Square enter a value or expression for the Inner width w; (SI unit: m). The

default is 5 cm.

* For Rectangular enter a value or expression for the Inner width w; (SI unit: m. The
default is 5 cm) and Inner height ; (SI unit: m. The default is 10 cm).

 For User defined enter a value or expression for the Cross sectional area A, (SI unit:
mz). The default is 0.01 m2. Enter the Wetted perimeter Z (ST unit: m). The default
is 0.4 m.

FLOW RESISTANCE

Select a Friction model.

Newtonian Fluids
Select Churchill (the default), Stokes, Wood, Haaland, Colebrook, Von Karman,

Swamee-Jain, or User defined.

* For Churchill, Wood, Haaland, Von Karman, or Swamee-Jain go to the Surface
Roughness section to select from a list of predefined values. Alternatively, enter

values or expressions.

¢ For User defined enter a value or expression for the Darcey friction factor /1

(dimensionless).

Non-Newtonian Fluids
For Power-law and Bingham fluids in tubes of circular cross section, the Irvine, Stokes,

and Darby friction models are available.

For more information about the friction models, see Expressions for the Darcy Friction

Factor.

SURFACE ROUGHNESS

This section is available if Churchill, Wood, Haaland, Von Karman, or Swamee-Jain is

selected as the Friction model.

Select a Surface roughness from the list—Smooth (0 mm), Drawn tubing (0.0015 mm) (the
default), Glass (0.0015 mm), Thermoplastics (0.0015 mm), Commercial steel (0.046 mm),
Wrought iron (0.046 mm), Steel welded seamless (0.061 mm), Asphalted cast iron (0.12
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mm), Galvanized iron (0.15 mm), Cast iron (0.26 mm), Wood stave (0.5 mm), Copper and

brass (0.61 mm), Concrete (1.5 mm), Riveted steel (4.5 mm), or User defined.

For User defined enter a value or expression for the Roughness (SI unit: m).

Phase Fractions

This node is available when Newtonian is selected as the Fluid model for the Pipe Flow
interface and then Gas-Liquid, friction factor multiplier or Gas-Liquid, effective Reynolds

number are also chosen.

Use the Phase Fractions node to define the gas fraction as area averaged void fraction

or a quality mass fraction.

GAS FRACTION
Select a Gas fraction specification—Area averaged void fraction (volume fraction) or

Quality (mass fraction).

* For Area averaged void fraction (volume fraction) enter an Area averaged void fraction
@ (dimensionless). The default is 0.

 For Quality (mass fraction) enter a Quality @ (dimensionless). The default is 0.

Initinl Values

The Initial Values node adds initial values for the pressure and tangential velocity that
can serve as an initial condition for a transient simulation or as an initial guess for a

nonlinear solver.

INITIAL VALUES
Enter values or expressions for the initial value of the Pressure p (SI unit: Pa) and the

Tangential Velocity u (SI unit: m/s).
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Inlet

Use the Inlet node to set the velocity, volumetric flow rate, or mass flow rate inlet
conditions that describe the fluid flow condition at an inlet.

In most cases the inlet boundary conditions appear, some of them slightly
modified, in the Outlet type as well. This means that there is nothing in
= the mathematical formulations to prevent a fluid from leaving the domain

through boundaries where the Inlet type is specified.

CHAPTER 2:

INLET SPECIFICATION
Select a Specification for the inlet—Mass flow rate (the default), Velocity, Volumetric flow

rate. Additionally, Pump and Reservoir options are available for the Pipe Flow interface.

* For Mass flow rate enter a value or expression for the Mass flow rate q,,  (SI unit:
kg/s). The default is 0 kg/s.

* For Velocity enter a value or expression for the Velocity u¢ (SI unit: m/s). The
default is 0 m/s.

* For Volumetric flow rate enter a value or expression for the Volumetric flow rate g,
(ST unit: ms/s). The default is 0 ms/s.

* For Standard flow, SCCM enter a value for standard cubic centimeters per minute. The
standard pressure and standard temperature as well as mean molar mass are required
as inputs as well. A standard cubic centimeter of gas is the amount of molecules
occupying a cubic centimeter at a specified standard temperature and pressure,
calculated by the ideal gas law. When used in the oil and gas industry, the standard
is often 15 degrees C and 100 kPa, but there are many other slightly different
standard conditions used in other circumstances. The inlet velocity calculation is

done according to

10 °p M

U= BOT,ApR, ¥scem

* For Pump enter a value for the External pressure pgy (SI unit: Pa) and define the
relationship between the head and the volumetric flow rate— Pump curve data, or
User defined.

Pump Curve Data
When Pump curve data is selected as the Pump curve, a table appears, in which the

values of the Flow rate and the Head can be either specified or imported from a text file
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by clicking the Load from file button ( = ) under the table. The interpolation between
points given in the table is defined using the Interpolation function type list in the Pump
Curve Interpolation section. Units can be specified for the Flow rate and the Head in the

Units section.

User Defined

With the User defined option, an expression for the Pump curve can be specified. The
flow rate across the point where this boundary condition is applied is defined by
phys_1d.V0 where phys id is the name (by default for pipe flow, phys id is pfl).
In order to avoid unexpected behavior, the function used for the pump curve returns

the maximum of the user-defined function and 0.

¢ For Reservoir enter values for reservoir density and pressure. Select a Entrance type—
Projecting (K = 1) (the default), Sharp edged (K = 0.5), Rounded (K = 0.05), or User-

defined loss coefficient.

Outlet

Use the Outlet node to set the velocity, volumetric flow rate, or mass flow rate point

conditions that describe the fluid flow condition at an outlet.

See Inlet for all settings.

i

All of the formulations for the Outlet type are also available, possibly
slightly modified, in other boundary types as well. This means that there
is nothing in the mathematical formulations to prevent a fluid from
entering the domain through boundaries where the Qutlet boundary type
is specified.

No Flow

Use the No Flow node to define plugged exits or inlets (no flow).

Lossless Fitting

The Lossless Fitting node models junctions without losses. It is a default feature,

imposed at all junction points, that will be overridden by subsequent Bend, Valve,

THE PIPE FLOW INTERFACE

27



28 |

Contraction/Expansion, Pump, T-junction, Y-junction, and n-way junction nodes

applied at overlapping points.

Pressure

Use the Pressure node to define the boundary pressure at points. The pressure
condition can only be applied to a point which is connected to exactly one edge (inlet

or outlet of a system).

BOUNDARY PRESSURE
Enter a value or expression for the Pressure p( (SI unit: Pa). The defaultis 101325 Pa.

CONSTRAINT SETTINGS
To display this section, click the Show button ( “& ) and select Advanced Physics Options.

Bend

Use the Bend node to introduce additional pressure losses due to irreversible turbulent

friction in a point associated with a bend in the pipe system.

The Bend can only be applied to a point which is connected to exactly two

= edges.

CHAPTER 2:

BEND SPECIFICATION
Select a Bend—90 degrees standard elbow (K = 0.9) (the default), 45 degrees standard
elbow (K = 0.5), or User-defined loss coefficient. For User-defined loss coefficient cnter a

Loss coefficient K (dimensionless).

CONSTRAINT SETTINGS
To display this section, click the Show button (“& ) and select Advanced Physics Options.
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Valve

Use the Valve node to introduce additional pressure losses due to irreversible turbulent
friction in a point associated with the position of a valve in the pipe system. Select a

predefined valve type or provide a user-defined loss coefficient.

— e —

The Valve can only be applied to a point which is connected to exactly two
= edges.

VALVE SPECIFICATION

Select a Valve—Globe valve (K = 10) (the default), Angle valve (K = 4.4), Gate valve (K =
0.2), Ball valve (K = 4.5), Butterfly valve (K = 0.6), Swing check (K = 2.5), or User-defined
loss coefficient. For User-defined loss coefficient cnter a Loss coefficient Kf

(dimensionless).

CONSTRAINT SETTINGS
To display this section, click the Show button (“& ) and select Advanced Physics Options.

Contraction / Expansion

Use the Contraction/Expansion node to introduce additional pressure losses due to
irreversible turbulent friction in a point associated with the position of a contraction or

expansion in the pipe system.

AT

T W

The Contraction/Expansion can only be applied to a point which is

= connected to exactly two pipe segments.
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CONTRACTION SPECIFICATION
Select an option from the Friction list—Sudden (the default), Gradual, or User-defined

loss coefficient.

¢ For Gradual enter an Angle of convergence « (SI unit: radians). The default is
0 radians.

* For User-defined loss coefficient enter a Loss coefficient K, (dimensionless). The
default is 0.

CONSTRAINT SETTINGS
To display this section, click the Show button ( “& ) and select Advanced Physics Options.

Pumyp

Use the Pump node to introduce a pressure jump in a point associated with the position

of'a pump in the pipe system. Alternatively, specify a fixed mass flow rate for the pump.

_Q—>

. The Pump can only be applied to a point which is connected to exactly
= two edges.

CHAPTER 2:

PUMP SPECIFICATION
Select a Pump direction (available options are based on space dimension)—Pesitive X
direction (the default), Negative X direction, Positive Y direction, Negative Y direction,

Positive Z direction, or Negative Z direction.

Select an option from the Type list—Fixed flow rate (the default), Downstream pressure,
Pressure increase, and Pump curve.

* For Fixed flow rate enter a value or expression for the Mass flow rate m

pump (S unit:
kg/s). The default is 0 kg/s.

¢ For Downstream pressure enter a value or expression for the Pressure pg,,,, (SI unit:
Pa). The defaultis 101 325 Pa.
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* For Pressure increase enter a value or expression for the Pressure increase Ap (SI unit:
Pa). The default is O Pa.

* Pump curve specifies an relationship between the head and the volumetric flow
rate— Pump curve data, or User defined.

Pump Curve Data

When Pump curve data is selected as the Pump curve, a table appears, where values of
the Flow rate and the Head can be specified or imported from a text file by clicking the
Load from file button ( = ) under the table. The interpolation between points given in
the table is defined using the Interpolation function type list in the Pump Curve
Interpolation section. Units can be specified for the Flow rate and the Head in the Units

section.

User Defined

With the User defined option, an expression for the Pump curve can be specified. The
flow rate across the point where this boundary condition is applied is defined by
phys_1d.V0 where phys id is the name (by default for pipe flow, phys id is pfl).
In order to avoid unexpected behavior, the function used for the pump curve returns
the maximum of the user-defined function and 0.

T-Junction

Use the T-Junction node to specify additional energy losses due to irreversible turbulent

friction in a T-junction, which can act as a split or a merger.
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Several options to specify pressure drop across the junction branches are available.

pjunclian
v
Prnain Prnain
Pside

Figure 2-1: A T-junction with local pressure indications.

The T-junction is intended for a point that is connected to exactly two
collinear main branches and one perpendicular side branch. If this

condition is not met, a warning message will be issued when solving. The

[

flow can go in either direction through each of the main branches and the
side branch. See Figure 2-1.

CHAPTER 2:

FRICTION SPECIFICATION

The Loss coefficients option allows you to enter a value or expression for the Loss
coefficient main branch K .;, for the energy loss between main branch and junction
(the defaultis 0.1) and the Loss coefficient side branch K, for the energy loss between
the side branch and junction (the defaultis 1.2). Both are dimensionless numbers. See

Figure 2-1.
The respective losses are calculated as

‘ 1 2

1 2
pmain, 1t meain, lu'main7 1 _pjunction = §Kf, mainpmain, lumain, 1

1
~ 97 mainpmain, Zumain, 2

P main, 2 t épmain, Zumain, ) _pjunction

1 2
= QKf, side Pside¥side -

1 2
Pside T Epsidcuside _pjunction

For Nonisothermal Pipe Flow and Reacting Pipe Flow interface interfaces, the

respective pressure drops are calculated as

Lo
‘pmain, 1 _pjunction| 9 fs mainpumain, 1
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_ 1K 2
|pmain, 2 _pjunction‘ - é 1, mainpumain, 2

_ 1 K 2
lpside _pjunction| - Q f,sidcpuside .

The advantage of using loss coefficients is that they are readily available in engineering
tables and textbooks.

The Loss coefficients, extended model option is available for the Pipe Flow interface.
This option allows you to specify the loss coefficient in more details and account for
the flow directions. Enter values or expressions for the six dimensionless loss
coefficients. See Figure 2-2.

5 )‘
Kmm Kinm
E—— E——

A ny! e N [ S
Kims Kim Kim  Kins Kins Kim
Figure 2-2: T-junction, joining and separating flows.

The losses for the outgoing branches are calculated as

0 1 2 _vlg 2
pav,in_pj,out_Q pj,outu jout — Z 9 *iin jout pi,iﬂu i,in
i, in

The total pressure is assume to be equal for all incoming branches:

0o _ 1 2
pav,in - pj,out + 2pj,outu jout

Use the Pressure drops option to specify a value or expression for the pressure drop

explicitly for each branch respectively:
Apl, s = pmain, 1~ Pside

ApQ, s =pmain, 2 7 Pside

Main 1 is the main pipe segment that has the lower index of the two in the selection
list (for example, see the list in Pipe Properties).

THE PIPE FLOW INTERFACE

33



ADVANCED SETTINGS
The angle tolerance is used to specify the tolerance to a geometry not being a perfect
T. Increase the tolerance if you get an error message but accept the geometry even if

does not fulfill the requirements for an Y-shape.

CONSTRAINT SETTINGS
To display this section, click the Show button ("= ) and select Advanced Physics Options.

Y-Junction

Use this feature to specify additional losses due to irreversible turbulent friction in a
Y-junction, which can act as a split or a merger. The pressure drop is calculated

according to
1 2
Ap = §Kfpu ,

where Kf is a loss factor.

Alternately, specify the pressure drop as a user-defined expression.

Pside —x

pjunclian —

Figure 2-3: A Y-junction with local pressuve indications.

The Y-junction can only be applied to a point that is connected to exactly
two side branches and one main branch. The angle between each of the

side branches and main must be equal, and must not be 120 degrees. See

[

Figure 2-3. If these conditions are not met, use an n-way junction. The
flow can go in either direction through each of the main branches and the

side branch.

FRICTION SPECIFICATION
The Loss coefficients options allows you to enter a value or expression for the Loss

coefficient main branch K, for the energy loss between side and junction and the Loss
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coefficient side branch K .;, for the energy loss between the main branch and junction
(the default is 1.2). Both are dimensionless numbers. See Figure 2-3. The respective

pressure losses are calculated as

2

1 _ lK 2
psidc, 1t Epsidc, luside, 1 _pjunction - é f, sidcpsidc, lu’side7 1

1

2 = =K 2
= 587 sidePside, 2%4ide, 2

1
‘pside, 2t ipside, 2Uside, 2 _pjunction

1 2

P main + épmainumain _pjunction

1

= éKf, mainpmainumain .

For Nonisothermal Pipe Flow and Reacting Pipe Flow interface interfaces, the

respective pressure drops are calculated as

_ 1 K 2
|psidc, 1 _pjunction| - § f, sidcpusidc, 1

1 K 2
|psidc, 2 _pjunction‘ = 9% side Uside, 2

‘p main _pjunction| = QKf, mainP % main -

The advantage of using loss coefficients is that they are readily available in engineering
tables and textbooks.

Use the Pressure drops option to specify a value or expression for the pressure drop
explicitly for each branch respectively:

Apl, m= |pmain _psidc, l|

ApZ, m = |pmain _psidc, 2|

Side 1 is the main pipe segment that has the lower index of the two in the selection list

(for example, see the list in Pipe Properties).

ADVANCED SETTINGS

The angle tolerance is used to specify the tolerance to a geometry not being a perfect
Y. Increase the tolerance if you get an error message but accept the geometry even if
does not fulfill the requirements for an Y-shape.
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CHAPTER 2:

CONSTRAINT SETTINGS
To display this section, click the Show button (& ) and select Advanced Physics Options.

n-Way Junction

Use the n-Way Junction feature to specify additional pressure losses due to irreversible
turbulent friction in an n-way junction that does not fall into the categories Y- or
T-junctions. The number of pipe connections to a point can be any number, and the

angles between the connection pipes arbitrary.

Phranch —v’ Pbranch

v

vl B
pjunclian Phranch

Figure 2-4: An n-Way Junction with local pressuve indications.

FRICTION SPECIFICATION
The Loss coefficients options allows you to enter a value or expression for the Loss
coefficient main branch Ky ... 1, for the energy loss between branch and junction.

The pressure loss is calculated as

1 2 1 K 2
P branch, i + épbranch, i’branch, i _pjunction - 5 branchpbranch, iubranch, i

For Nonisothermal Pipe Flow and Reacting Pipe Flow interfaces, the pressure drop is

calculated as
1 K 2
|p branch, i -p junction| - é branchP ubranch, i

Internal Pressure Lock

Use the Internal Pressure Lock node to specify the pressure at a point. The Internal
Pressure Lock condition can only be applied to a point which connects exactly two

edges.
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Pipe Flow Physics Feature Symbols

For pipe flow interface, the physics symbols are available for internal points boundary
conditions. To display the boundary condition symbols listed in Table 2-1, enable the
Show physics symbols from the Graphics and Plot Windows menu on The Preferences
Dialog Box. The check box is not selected by default.

These symbols are available with the applicable pipe flow feature nodes in the Pipe
Flow interface are reproduced in the table below:

TABLE 2-1: PIPE FLOW BOUNDARY CONDITION PHYSICS SYMBOLS

SYMBOL SYMBOL NAME DISPLAYED BY NODE
D Bend Bend
] Valve Valve
=
=] Pump Pump
= Contraction/Expansion Contraction/Expansion

T-Junction T-Junction

n-Way Junction n-Way Junction

T
hid Y-Junction Y-Junction
5

Pipe Connection

Use the Pipe Connection feature to couple a Pipe Flow interface with a Laminar Flow
interface. This feature is also available with the Creeping Flow interface if you have the
additional modules with the applicable license.

PIPE CONNECTION

This feature couples a 1D pipe segment modeled with the Pipe Flow interface with a
3D single phase flow body. After adding a Pipe Connection feature to both the

THE PIPE FLOW INTERFACE



single-phase flow interface and the Pipe Flow interface, choose an option from the list
to couple the two physics interfaces.

¢ The Pipe Flow interface adds the Pipe Connection to an end point of a pipe.

¢ The Single Phase flow interface adds the Pipe Connection to a 2D surface that

comprises an orifice in a 3D body.

¢ When both connections have been added the should be configured to point to each
other.

e The connection ensure continuity in pressure and velocity across the connection,

regardless of flow direction. The flow may switch direction during a simulation.

Convective Flow in o Heat Exchanger Plate: Application Library path
ﬂ]]] Pipe_Flow_Module/Heat_Transfer/heat_exchanger_plate
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The Nonisothermal Pipe Flow
Interface

The Nonisothermal Pipe Flow (nipfl) interface (£ ), found under the Nonisothermal
Flow branch () when adding a physics interface, is used to compute the
temperature, velocity, and pressure fields in pipes and channels of different shapes. It
approximates the pipe flow profile by 1D assumptions in curve segments, or lines.
These lines can be drawn in 2D or 3D and represent simplifications of hollow tubes.
The physics interface is available in 3D on edges and 2D on boundaries.

When this physics interface is added, these default nodes are also added to the Model
Builder — Fluid, Pipe Properties, Pressure, Temperature, and Initial Values. Then, from
the Physics toolbar, add other nodes that implement, for example, boundary

conditions and volume forces. You can also right-click Nonisothermal Pipe Flow to select

physics features from the context menu.

SETTINGS
The Label is the default physics interface name.

The Name is used primarily as a scope prefix for variables defined by the physics
interface. Refer to such physics interface variables in expressions using the pattern
<name>.<variable_name>. In order to distinguish between variables belonging to
different physics interfaces, the name string must be unique. Only letters, numbers, and

underscores (_) are permitted in the Name field. The first character must be a letter.
The default Name (for the first physics interface in the model) is nipf1l.

FLUID MODEL

Select a Fluid model—Newtonian (the default), Power law, or Bingham.

DEPENDENT VARIABLES

This physics interface defines these dependent variables (fields). If required, edit the
name, but dependent variables must be unique within a model:

* Pressure p (SI unit: Pa)

* Tangential velocity u (SI unit: m/s)

¢ Temperature 7" (SI unit: K)

THE NONISOTHERMAL PIPE FLOW INTERFACE



DISCRETIZATION

To display this section, click the Show button ("& ) and select Discretization.

FURTHER READING

e For an explanation of the tangential velocity, see Theory for the Pipe
Flow Interface.

@l * Edge, Boundary, Point, and Pair Nodes for the Nonisothermal Pipe
Flow Interface

e Theory for the Heat Transfer in Pipes Interface

Insulation of o Pipeline Section: Application Library path
ﬂ]]] Pipe_Flow_Module/Heat_Transfer/pipeline_insulation

Edge, Boundary, Point, and Pair Nodes for the Nonisothermal Pipe
Flow Interface

Because The Nonisothermal Pipe Flow Interface is a multiphysics interface it shares
many nodes with other physics interfaces. These boundary, edge, point, and pair nodes

are available as indicated (and listed in alphabetical order).
Described in this section:

¢ Fluid

e Heat Transfer

These nodes are described for the Reacting Pipe Flow interface:

¢ Fluid Properties

e Properties

These nodes are described for the Heat Transfer in Pipes interface:
e External Film Resistance

¢ Internal Film Resistance

* Wall Heat Transfer

e Wall Layer
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These nodes are described for the Heat Transfer interface in the COMSOL
Multiphysics Reference Manual:

e Heat Source
¢ Outflow

e Temperature

These nodes are described for the Pipe Flow interface (listed in alphabetical order):

* Bend ¢ Pipe Connection
¢ Contraction / Expansion e Pressure

e Inlet e Pump

e No Flow e T-Junction

* n-Way Junction e Valve

* Outlet * Volume Force

¢ DPhase Fractions ¢ Y-Junction

In the COMSOL Multiphysics Reference Manual see Table 2-3 for links
to common sections and Table 2-4 to common feature nodes. You can
n also search for information: press F1 to open the Help window or Ctrl+F1

to open the Documentation window.

Fluid

Use the Fluid node to define the density, dynamic viscosity, and heat convection and
conduction properties.

PRESSURE WORK

The Pressure Work section has s check box where a pressure work term can be
activated. When checked a contribution to the right-hand side of the Heat Transfer in
Pipes equation is added.

This term can be important to activate if the pressure drop is expected to be
considerable and the fluid is compressible. The pressure-volume work is added to the

energy balance.

For more information, see the section Theory for the Heat Transfer in Pipes Interface.
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CHAPTER 2:

FLUID PROPERTIES
The default Density p and Dynamic viscosity is specified here.

HEAT CONVECTION AND CONDUCTION
The default Heat capacity at constant pressure C,, (SI unit: ] /(kg-K)), Ratio of specific
heats y (dimensionless), and Thermal conductivity % (SI unit: W/(m-K)) all use values

From material. For User defined enter different values or expressions.

Heat Transfer

Use the Heat Transfer node to define the density, yield stress, plastic viscosity, and heat

convection and conduction properties.

FLUID PROPERTIES
The default Density p (SI unit: l(g/ms) is User defined and is 1 x 103 kg/ms.

Enter a value or expression for the Yield stress 7, (SI unit: Pa) and Plastic viscosity
(ST unit: Pa-s). The defaults are 0 Pa and 0 Pa-s, respectively.

HEAT CONVECTION AND CONDUCTION
The default Heat capacity at constant pressure C,, (SI unit: ] /(kg-K)), Ratio of specific
heats y (dimensionless), and Thermal conductivity %2 (SI unit: W/(m-K)) all use values

From material. For User defined enter different values or expressions.
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The Water Hammer Interface

The Water Hammer (whtd) interface (1(01), found under the Fluid Flow>Single-Phase
Flow branch (=) when adding a physics interface, is used to compute the velocity and
pressure fields for propagation of a hydraulic transient, also known as a water hammer,
in elastic pipe systems. For example, the propagation of a water hammer in a piping

system of an oil refining plant.

The equations governing the propagation of hydraulic transients in pipes stem from
considering momentum, mass, and energy balances for a control volume of a piece of
pipe. In the formulation of the Water Hammer interface, the compressibility effects of
the fluid and pipe walls are linearized. The resulting equations are expressed in the
cross-sectional averaged variables and reduce the equations to a 1D component with
scalar field variables. The physics interface is available in 3D on edges and at points,

and in 2D on boundaries and points.

When this physics interface is added, these default nodes are also added to the Model
Builder—Fluid Properties, Pipe Properties, Closed, and Initial Values. Then, from the
Physics toolbar, add other nodes that implement, for example, boundary conditions.
You can also right-click Water Hammer to select physics features from the context

menu.

SETTINGS

The Label is the default physics interface name.

The Name is used primarily as a scope prefix for variables defined by the physics
interface. Refer to such physics interface variables in expressions using the pattern
<name>.<variable_name>. In order to distinguish between variables belonging to
different physics interfaces, the name string must be unique. Only letters, numbers and

underscores (_) are permitted in the Name field. The first character must be a letter.
The default Name (for the first physics interface in the model) is whtd.
DEPENDENT VARIABLES

This physics interface defines these dependent variables (fields). If required, edit the

name, but dependent variables must be unique within a model:

* Pressure p (SI unit: Pa)

* Tangential velocity u (SI unit: m/s)
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DISCRETIZATION

To display this section, click the Show button ("& ) and select Discretization.

In the COMSOL Multiphysics Reference Manual see Table 2-3 for links
to common sections and Table 2-4 to common feature nodes. You can
n also search for information: press F1 to open the Help window or Ctrl+F1

to open the Documentation window.

¢ Edge, Boundary, Point, and Pair Nodes for the Water Hammer
,@l Interface

* Theory for the Pipe Flow Interface

Water Hammer: Application Library path Pipe_Flow_Module/

ﬂ:ﬂ] Verification_Examples/water_hammer_verification

Edge, Boundary, Point, and Pair Nodes for the Water Hammer
Interface

The Water Hammer Interface has these edge, boundary, point, and pair nodes available
and listed in alphabetical order:

¢ Closed * Pipe Properties
¢ Fluid Properties e DPressure
* Local Friction Loss * Velocity

¢ The Initial Values and Volume Force nodes are described for the Pipe Flow

interface.

In the COMSOL Multiphysics Refervence Manual see Table 2-3 for links
to common sections and Table 2-4 to common feature nodes. You can
n also search for information: press F1 to open the Help window or Ctrl+F1

to open the Documentation window.
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Fluid Properties

The Fluid Properties node adds the momentum equations solved by the physics
interface, except for volume forces which are added by the Volume Force node. The

node also provides an interface for defining the physical properties of the fluid.

PHYSICAL PROPERTIES

Select a Fluid model—Linear elastic (the default).

The default Density p (ST unit: kg/ ms) uses the value From material. For User defined

enter a different value or expression.

The default Dynamic viscosity £ (SI unit: Pa-s) uses the value From material and
describes the relationship between the shear rate and the shear stresses in a fluid.
Intuitively, water and air have a low viscosity, and substances often described as thick
(such as oil) have a higher viscosity.

The default Speed of sound ¢, (SI unit: m/s) uses the value From material. For User

defined enter a different value or expression.

Pipe Properties

The Pipe Properties node is used to define the pipe shape, pipe model, and flow

resistance.

PIPE SHAPE
The Pipe Shape settings are the same as for the Pipe Properties node described for the
Pipe Flow interface.

PIPE MODEL
Select a Pipe model—Zero axial stress (the default), Anchored at one end, Anchored at

both ends, or Incompressible cross section.
¢ For Zero axial stress sclect a Young’s modulus E—Not set (the default) or User defined.
If User defined is selected, enter a value or expression.

¢ For Anchored at one end or Anchored at both ends enter a value or expression for the
Young’s modulus E. Sclect a Poisson’s ratio v—Not set (the default) or User defined.

For User defined enter a value or expression.
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When Zero axial stress, Anchored at one end, or Anchored at both ends is sclected, also
select a Wall thickness A ww—Not set (the default) or User defined. For User defined enter

a value or expression.

FLOW RESISTANCE
The Flow Resistance settings are the same as for the Pipe Properties node described

for the Pipe Flow interface.

Local Friction Loss

Use the Local Friction Loss node to add a lumped friction loss that depends on the
velocity according to Equation 2-7.

FRICTION SPECIFICATION

Enter a Loss coefficient K (dimensionless). The default is 0.

CONSTRAINT SETTINGS
To display this section, click the Show button ( “& ) and select Advanced Physics Options.

Closed

Use the Closed node to impose zero velocity.

Velocity

Use the Velocity node to prescribe a velocity.

VELOCITY

Enter a value or expression for u;;, (SI unit: m/s). The defaultis 0 m/s.

Pressure

Use the Pressure node to define the boundary pressure at points.

PRESSURE

Enter a value or expression for the Pressure p (SI unit: Pa).

CONSTRAINT SETTINGS
To display this section, click the Show button (“& ) and select Advanced Physics Options.
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Theory for the Pipe Flow Interface

The Pipe Flow Interface and The Nonisothermal Pipe Flow Interface theory is

described in this section:
* Flow Equations
¢ Pipe Connections

* References for the Pipe Flow Interface

Flow Equations

The Pipe Flow Interface calculates the pressure and velocity of an incompressible or
weakly compressible fluid by solving the continuity and momentum equations

outlined below.

A one dimensional pipe can be present on a boundary in a 2D geometry, or on an edge

in a 3D geometry.

MOMENTUM AND CONTINUITY EQUATIONS

The momentum and continuity equations for flow in a pipe are given by (Ref. 16):

MW Vu = Vp i -
p5; +Pu Vu = -Vp fD2dhu\u| +F (2-1)
and
-8-3%9+V-(Apu) =0 (2-2)

The second term on the right-hand side in Equation 2-1 represents the pressure drop
due to viscous shear. Here, u is the cross section averaged velocity (SI unit: m/s), p
the density (ST unit: kg/ms),p pressure (SI unit: Pa), f (dimensionless) the Darcy
friction factor (see Expressions for the Darcy Friction Factor) and F is a volume force
term (SI unit: N/ms).

Furthermore, d}, is the mean hydraulic diameter (SI unit: m), given by:

d, =44

h — VA (2-3)
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where A is the pipe cross section area (SI unit: m?> ) available for flow, and Z is the

wetted perimeter (SI unit: m).

Figure 2-5: Unit tangent vector to the pipe axis.

Let

€ = ( €rx Cry et,z)

be the unit tangent vector to the pipe axis.
If the following assumptions apply:

e The velocity profile is fully developed with an entire pipe section.

¢ The cross section area is allowed to change between pipe segments and within pipe

segments.

* Empirical functions (friction charts) describe viscous pressure drop both for

turbulent and laminar flow regimes

e The curvature of the pipe segment gives rise to insignificant pressure loss in

comparison with wall friction.
* Shocks are neglected

¢ All velocity components normal to the pipe axis is assumed to be 0,

the momentum balance in Equation 2-1 can be rewritten as

e - [p%—;‘ +pu-Vu= —Vp—fD§%;u|u| + F} (2-4)

and we can define the tangential velocity u as u = ue_ . The pipe flow physics
interface in COMSOL Multiphysics solves for the tangential velocity . This is also the
quantity the user specifies in for example inflow boundary conditions and in the initial

conditions settings.
Curvature pressure drop effects can be added in points with the Bend feature.

Gravity can be included explicitly in the model, but when the variation in
density is negligible, and the model is not pressure driven (the inlet boundary
condition is a pressure setting), the only effect of including gravity is a change
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in the total pressure level. In those cases, it is therefore common modeling
practice to set the gravity F to 0 and interpret the pressure variable as the
reduced pressure p. = p - pg(z,—2), where zg is the datum level of the free
liquid surface. This reduces the model complexity and yields the same results.

The Darcy friction factor in Equation 2-1 accounts for the continuous pressure drop
along a pipe segment due to viscous shear, and is expressed as a function of the
Reynolds number (Re) and the surface roughness divided by the hydraulic diameter
(e / dh) .

e
o= fo(Re, 7 (2-5)
where
d
Re = P4%h (2-6)
N

The physics interface automatically calculates fp from one of the predefined
expressions Equation 2-8 through Equation 2-14.

Additional Flow Resistances

Additional flow resistance due to irreversible turbulent effects in joints and junctions
can be added as point conditions between pipe segments—Bends, Valves, T-junctions,
Y-junctions, n-way junctions, Contractions, and Expansions. These resistances give rise
to abrupt (lumped) energy losses due to turbulence in the points where they are added.

The lumped pressure drop is calculated as:
1 2
For more information about each type, see the interface descriptions in The Pipe Flow

Interface section.

Loss coefficients, K;, for turbulent flow are available in the literature (Ref. 14) and the

set predefined in the Pipe Flow interface is reproduced in the table below:

TABLE 2-2: LOSS COEFFICIENTS

FEATURE DESCRIPTION LOSS COEFFICIENT K
Bends 90° standard elbow 0.9

45° standard elbow 0.5
Valves Globe, fully open 10
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TABLE 2-2: LOSS COEFFICIENTS

FEATURE DESCRIPTION LOSS COEFFICIENT K
Angle, fully open 4.4
Gate, fully open 0.2
Ball, fully open 4.5
Butterfly, fully open 0.6
Swing check, fully open 2.5
T-junction T-junction split/merger 0.1 and 2.1 for side and main. See

Figure 2-1 for a description of flow
branches in a T-junction.

Contractions Sudden

0.5(1-p%

Gradual, angle of
convergence o < 22°

Gradual, angle of O.SM(I _B)

convergence o, > 22°

0.8sin(o)(1-B)

Expansions Sudden 2.2
(1-B%)
Gradual, angle of

. 2
convergence o < 22° 2.6sin(a)(1-P)

Gradual, angle of 9
convergence o, > 22° (1-B)

Above, B is the ratio of small to large cross-sectional area. The point friction losses
listed above apply for Newtonian fluids. Point losses applying to non-Newtonian flow

can be added as user-defined expressions, for instance from (Ref. 15).

For the point pressure loss features Bends, Valves, T-junctions, Y-junctions, n-way
junctions, Contractions, and Expansions, the pressure loss can also be specified as a
pressure drop Ap directly.

Expressions for the Darcy Friction Factor

Newtonian Fluids For single-phase fluids, the Churchill equation (Ref. 1) for the
Darcy friction factor can be used for the full range of Re (laminar, transition and
turbulent) and full range of e/d:

fo = 8[(1%) 12+(A+B)‘1"‘T/12 (2-8)

where
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A= [—2.457111((@0'9+o.27(e/d))}16 (2-9)
B = (371530)16 (2-10)

In the laminar regime (Re < 2000), fp is independent of the surface roughness and is

given by the Stokes formula:

_ o4

= Re (2-11)

o

The Wood equation (Ref. 2) gives the friction factor for 4000 < Re < 1107 and
1107 <e/d < 0.04, according to

0.225 0.44

fi = 0.094(e/d)*?* +0.53(e/d) + 88(e/d)"** - Re” (2-12)
with
a = -1.62(e/d)* 13 (2-13)

The Haaland equation (Ref. 3) for the Darcy friction factor is commonly used for oil
pipelines and wells. It can recover both small and large relative roughness limits for a
wide range of Reynolds numbers (4-103 <Re < 1-108)

E = —1.810g10((63% i +(%)) (2-14)

D

It can be rewritten as
(1/1.8)
e/ 1.11 6.9 2
(oze(57)  +(52)

For very low relative roughness e/d, the Haaland equation simplifies to Colebrook’s

1 6.9
/\/}-:—- = —1.810g10(§) (2-16)

D

fo = (2-15)

explicit formula (Ref. 4)

For very large relative roughness e/d, the Haaland equation simplifies to the von

Karman formula (Ref. 5)
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JFI = —1.810g10((% 1'11) = —210810(%]) (2-17)

D
An alternative to Haaland equation is the Swamee-Jain equation (Ref. 6)
0.25

(log 10((% * (3'67);}.9)) 2

The equation is valid for relative roughness 110 <e/d < 1.10°2 and for Reynolds
number in the range 5.10% < Re < 1.103.

(2-18)

fD=

All the above equations are selectable from a list of friction factor expressions. As
noted, only the Churchill equation covers both the laminar and turbulent flows, as well
as the transitional region in between these flow regimes. The equations by Wood,
Haaland, Colebrook, von Karman, or Swamee-Jain, intended for the turbulent regime,
are combined with the Stokes equation for laminar flow to cover all flow conditions.
When Re<1000, COMSOL Multiphysics selects Stokes equation if it predicts a friction
factor greater than equations for the turbulent regimes. This produces more accurate
results that using the turbulent frictions factors in the laminar regime, but it does not
necessarily produce accurate estimates of the friction factor in the transition region.
Therefore, it is always advisable to check the Reynolds number for a give pipe flow

solution and change the friction model and recalculate, if necessary.

The Newtonian fluid type also has two Gas-Liguid options, which employs a simple
two-phase approach presented by Balasubramaniam et al (Ref. 25). This is a one-fluid
approach that treats the fluid as one phase (one mass and momentum balance is
solved), but it corrects the pressure drop correlation with empirical factors for

liquid-gas mixtures. As such, the model also makes the following assumptions:

e The velocity of the gas and liquid phases are the same, meaning that no liquid
holdup is accounted for.

* No phase separation occurs due to gravity or other effects.

* No phase transition (condensation or vaporization) is assumed.

e The gas phase-fraction is assumed to be small so that the mixture is virtually

incompressible.

The first selectable method is the gas-liquid, friction factor multiplier, which
modifies the single-phase Newtonian Darcy friction factor defined in Equation 2-8 and

on, such that
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fp = @2 fo,1 (2-19)

where fp 1, is the Newtonian single phase friction factor computed as described earlier

in this section. f is then used as usual in the pressure drop correlation in Equation 2-4.
. 2 .

The two-phase friction factor ®“2p is calculated as (Ref. 25)

— — -1/4
% P_L[“%MM“%M} (2-20)
p PG Lg

where py , U; , pg and ug are the density and viscosity of the liquid, and gas,
respectively, and where @ is the quality (the gas phase mass fraction). The total
density in Equation 2-20 is calculated as

P =0gPg+(1-05)PL (2-21)
or
1
= — (2-22)
P %+(1—0)G)
PG Pr

where ¢, is the user provided volumetric void fraction. The user has a choice to either
enter gas phase mass fraction g or volumetric void fraction ¢ . The conversion
formula between the two is

0 = Log (2-23)
Pg

The second selectable gas-liquid method is the gas-liquid, effective Reynolds number.
This method uses an effective adjusted viscosity to calculate the Reynolds number in
the pressure loss calculations. The default mixture viscosity model is the extended
Einstein, which probably is the most accurate within a large range of gas mass fractions
(Ref. 26):

(M1 +2.506)/ (M, + Mg
W=y (1-0g) (ML +2.506)/ (M + He) (2-24)

and the other options are

Linear average
W=pp(1-0g5)+Ughg (2-25)

Reciprocal average
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(2-26)

Liquid viscosity
W=y (2-27)

User defined.

Non-Newtonian Power-law Fluids For Power-law fluids the apparent viscosity is related
to the shear rate as

w= m(g—%’)nfl (2-28)

where m and n are two empirical curve fitting parameters known as the fluid
consistency coefficient and the flow behavior index, respectively. In the laminar regime
the friction factor for power law fluids can be calculated by the Stokes equation using
the modified Reynolds number proposed by Metzner and Reed (Ref. 7):

64
v = (2-29)
P Reyy
Rey = P (2-30)
MR 8(n—1)m(3n+1)n
4n

For the turbulent regime Irvine (Ref. 8) proposed the following expression for the
friction factor:

fo = 4(1[;@(;9 (2-31)

where

D(n) =

2("+4)( 4n )3112 (2-32)

77n 3n+1

Ryan and Johnson (Ref. 9) formulated a criterion for the transition between laminar

and turbulent flow, where
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()
Reyp = ~ 220 (94p) 1" (2-33)
Bn+1)

predicts the critical Reynolds number.
Non-Newtonian Bingham Plastic Model. The Bingham model describes viscoplastic
fluid with a yield stress:
d
T=Tp+ pB(&Y) for [t] > |1p]|

(%%() =0 for |1 < |t

(2-34)

The yield stress, Tg (SI unit: Pa), and the plastic viscosity, ug (SI unit: Pa-s), are found
by curve fitting to experimental data.

The Swamee-Aggarwal equation (Ref. 10) gives the friction factor for a Bingham
plastic fluid in the laminar regime according to:

1.143
10.67 + 0.1414(%—)
64 B He
fD laminar = Ra_ T 1.16 (_) (2-35)
, . R
Reg (1 + 0.149(RH—;%) )ReB B
where
ud
ey = pu h (2-36)
B
and
d,t
He = ZhB (2-37)
Up
is the Hedstrom number.
For turbulent flow Darby (Ref. 11) provided the equation:
ao, —0.193
fD, turbulent = 4-10 RCB (2-38)

with
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ag = -1.47(1 + exp(-2.9 - 10 "He)) (2-39)

as well as an equation covering all flow regimes:

1
b
fD = (f%,laminar+f]‘s,turbulcnt) (2-40)
where
b = 1.7 + 20000 (2-41)
Rep

The non-Newtonian friction models outlined above do not include any
effects of wall roughness. Since the laminar sub-layers tend to be thicker
than non-Newtonian than for Newtonian fluids, the effect of pipe

[

roughness is likely to be smaller. Friction models including the surface
roughness can be used as user-defined specifications and can be found in
for example (Ref. 12).

The non-Newtonian friction models outlined above apply for pipes with circular

cross-section. The generalized Reynolds number needs to be modified to account for
other cross-sections.

Surface Roughness

Values of the absolute surface roughness found in the literature (Ref. 13 and Ref. 14)
are reproduced in the table below:

TABLE 2-3: SURFACE ROUGHNESS

TUBEMATERIAL :gtlz\:ﬁess (MM)
Smooth 0

Drawn tubing 0.0015

Glass 0.0015

Thermoplastics 0.0015
Commercial steel  0.046
and wrought iron

Steel, welded 0.061

seamless

Asphalted cast 0.12

iron
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TABLE 2-3: SURFACE ROUGHNESS

TUBE MATERIAL SURFACE
ROUGHNESS (MM)

Galvanized iron 0.15

Cast-iron 0.26

Wood stave 0.18-0.9

Concrete 0.3-3

Riveted steel 0.9-9

Copper and brass  0.61

Pipe Connections

Pipe connections are available when the Pipe Flow interface and a Single-phase flow
interface is available in the same model components. It connects a pipe-flow section to

a 3D fluid flow domain. See further Pipe Connections.
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CHAPTER 2:

In this section:

* Flow Equations

e Reference for the Water Hammer Interface

Flow Equations

The Water Hammer interface implements both the continuity equation and the
momentum equations for a compressible fluid traveling inside pipes of variable cross

section.

THE CONTINUITY EQUATION

The mass conservation for a fluid inside a pipe is given by:

%B +V-(Apw) = 0 (2-42)

where A (SI unit: m? ) is the cross section area of the pipe, p (SI unit: kg/ms) is the
fluid density, and u (SI unit: m/s) is the tangential fluid velocity.

For adiabatic processes, the density and cross section area are function of the pressure,

so the continuity equation reads

ARRD) v Ap)pEw) = 0 (2-43)
In a first order approximation, this equals

1  1\odp

Agpo( 7+ 7 ) L + V- (Agpgu) = 0 (2-44)
oFo Kp KA ot oFo

where K, is the bulk modulus of the fluid (the inverse of its compressibility), and K4

is the effective bulk modulus of the cross section area. Ag and pg are the reference area

and reference density at a given pressure py.

The Water Hammer wave speed ¢ (SI unit: m/s) is given by a combination of fluid and

structural material properties
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clz = pO(I%p +KLA) (2-45)

The effective bulk modulus for the cross sectional area K4 (SI unit: Pa) is given by the
pipe’s material properties

w
K, = E=2
dh
where E is the Young’s modulus, d}, is the hydraulic diameter, and wyy, is the pipe’s
wall thickness. This is the so-called Korteweg formula (Ref. 1)

The Korteweg formula can also be extended to pipes suffering from axial stresses, in
this case, a more general formula would include the Poisson’s ration v of the pipe’s

material

EWy,

4= 1a,

(2-46)
where { = 1 for pipe with zero axial stress (this is Korteweg’s original formula for a
pipe furbished with expansion joints), { = 1-v/2 for a pipe anchored at one end,
and £ = 1- v2 fora pipe anchored at both ends.

THE MOMENTUM EQUATION
The momentum equation is written as:

u_ g o P )
Pz = Vp fD2dhu\u\+F (2-47)

here, fp is the Darcy friction factor, normally a function of the Reynolds number, the
surface roughness and the hydraulic diameter, as described in Expressions for the

Darcy Friction Factor.

This set of equations are normally acknowledged as the Water Hammer equations, and

are they mainly written in the literature as (consider gravity forces, so F = pg)

;15%3 +V-(Apw) = 0 (2-48)
peY - ~Vp-fozgulul +pg (2-49)
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BOUNDARY CONDITIONS

The available boundary conditions are Closed, Pressure, Velocity, and Additional Flow
Resistances.

Reference for the Water Hammer Intevface

1. M. Ghidaoui et al., “A Review of Water Hammer Theory and Practice,” Appl.
Mech. Rev. 58, pp. 49-76, 2005.
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Heat Transfer Interfaces

This physics interface, which is found under the Heat Transfer branch ( (|| ) when
adding a physics interface, has functionality for simulating heat transfer in pipe

networks, including wall heat transfer to the surroundings.
In this chapter:
* The Mechanisms for Heat Transfer

¢ The Heat Transfer in Pipes Interface

e Theory for the Heat Transfer in Pipes Interface

See The Heat Transfer Interfaces in the COMSOL Multiphysics Reference

Manual for other Heat Transfer interface and feature node settings.
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The Mechanisms for Heat Transfer

The Heat Transfer in Pipes interface (5 ), found under the Heat Transfer branch ( ({| )
when adding a physics interface, solves a temperature equation for a fluid transported
in a pipe. The physics interface requires the fluid velocity as input, provided either by
the user or by coupling to the Pipe Flow interface. However, it is advisable to instead
use The Nonisothermal Pipe Flow Interface which is a multiphysics interface that
combines Pipe Flow and Heat Transfer in Pipes to model the velocity, pressure and

temperature fully coupled.

The Heat Transfer in Solids, Heat Transfer in Fluids (general convection and
conduction, nonisothermal flow, and conjugate heat transfer), and Joule
Heating interfaces all belong to the COMSOL Multiphysics base package.
See The Heat Transfer Interfaces in the COMSOL Multiphysics

Reference Manual for more information.

[

COUPLING TO OTHER PHYSICS INTERFACES

It is often relevant to couple heat transport in pipe networks to heat transfer in the
region surrounding the pipe network. Simulating the cooling of a mold is a good
example of such an application. The Heat Transfer in Pipes interface or the
Nonisothermal Pipe Flow interface can be used to model the removal of heat in the
cooling channels represented by 1D edges, and couple that heat loss to a 3D model of
the mold. The pipe heat model is automatically coupled to the 3D surroundings.

More extensive descriptions of heat transfer, such as 3D turbulent flow models or
problems involving surface-to-surface radiation, can be found in the Heat Transfer
Module. Furthermore, some cases that involve geothermal applications with
groundflow models for porous media are better handled by the Subsurface Flow
Module.
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The Heat Transfer in Pipes Interface

The Heat Transfer in Pipes (htp) interface (B ), found under the Heat Transfer
branch ( ||( ) when adding a physics interface, is used to model heat transter by
conduction and convection in pipes and channels of different shapes, where the fluid
velocity and pressure fields are known a priori. It provides 1D models to define the pipe
flow profile and temperature profiles on curve segments, or lines. These lines can be
drawn in 2D or 3D and represent simplifications of hollow tubes. Wall heat transfer,

including multilayer walls and cladding is included as an option.

The temperature equation corresponds to a 1D convection-diffusion equation that

may contain additional contributions like heat sources.

The Nonisothermal Pipe Flow Interface extends this physics interface by providing

equations to compute the velocity and pressure fields when they are unknown.

When this physics interface is added, these default nodes are also added to the Model
Builder—Heat Transfer, Pipe Properties, Temperature, and Initial Values. Then, from the
Physics toolbar, add other nodes that implement, for example, boundary conditions.
You can also right-click Heat Transfer in Pipes to sclect physics features from the context

menu.

SETTINGS
The Label is the default physics interface name.

The Name is used primarily as a scope prefix for variables defined by the physics
interface. Refer to such physics interface variables in expressions using the pattern
<name>.<variable_name>. In order to distinguish between variables belonging to
different physics interfaces, the name string must be unique. Only letters, numbers and

underscores (_) are permitted in the Name field. The first character must be a letter.

The default Name (for the first physics interface in the model) is htp.

DEPENDENT VARIABLES
This physics interface defines the Temperature T (SI unit: K) dependent variable (field).

If required, edit the name, but dependent variables must be unique within a model.
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DISCRETIZATION

To display this section, click the Show button ("& ) and select Discretization.

* Edge, Boundary, Point, and Pair Nodes for the Heat Transfer in Pipes
Interface
@l * Theory for the Heat Transfer in Pipes Interface

* Handling Frames in Heat Transfer in the COMSOL Multiphysics
Reference Manual

Edge, Boundary, Point, and Pair Nodes for the Heat Transfer in Pipes
Interface

The Heat Transfer in Pipes Interface has these boundary, edge, point, and pair nodes
available from the Physics ribbon toolbar (Windows users), Physics context menu (Mac

or Linux users), or right-click to access the context menu (all users).

In general, to add a node, go to the Physics toolbar, no matter what
'g' operating system you are using. Subnodes are available by clicking the
parent node and selecting it from the Attributes menu.

¢ Heat Outflow e DPipe Properties
¢ Heat Source e Temperature
e Heat Transfer ¢ Wall Heat Transfer

e Initial Values

In the COMSOL Multiphysics Refervence Manual see Table 2-3 for links
to common sections and Table 2-4 to common feature nodes. You can
n also search for information: press F1 to open the Help window or Ctrl+F1

to open the Documentation window.

Heat Transfer

Use the Heat Transfer node to define the tangential velocity, density, dynamic viscosity,

and heat convection and conduction properties.
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FLUID PROPERTIES
The default Density p (ST unit: kg/ms) uses the value From material. For User defined

enter a different value or expression.

The default Dynamic viscosity # (SI unit: Pa-s) uses the value From material and
describes the relationship between the shear rate and the shear stresses in a fluid.
Intuitively, water and air have a low viscosity, and substances often described as thick

(such as oil) have a higher viscosity.

HEAT CONVECTION AND CONDUCTION

Select an option from the Tangential velocity list—User defined, Tangential velocity
(nipfl/nipfl), or Tangential velocity (pfl/pfl). For User defined enter a value for the
Tangential velocity z (SI unit: m/s).

The default Density p (SI unit: kg/ms), Dynamic viscosity £ (SI unit: Pa-s), Heat capacity
at constant pressure C}, (SI unit: ] /(kg-K)), Ratio of specific heats y (dimensionless),
and Thermal conductivity £ (SI unit: W/(m-K)) all use values From material. For User

defined enter different values or expressions.

Heat Source

The Heat Source describes heat generation within the domain. Express heating and
cooling with positive and negative values, respectively. Add one or more nodes as
needed—all heat sources within a domain contribute to the total heat source.

HEAT SOURCE

Click the General source, Linear source or Heat rate button.

¢ For General source enter a value for the distributed heat source @ (SI unit: W/m3).

* For Heat rate enter a value for the heat rate Py(SI unit: W). In this case @=P/L

where L is the total length of the selected boundaries.

* For Linear source (Q = g4 T) enter the Linear heat source g4 (SI unit: W/(mSK))

The advantage of writing the source in this form is that it can be stabilized
by the streamline diffusion. The theory covers g4 that is independent of
=] the temperature, but some stability can be gained as long as g is only

weakly dependent on the temperature.
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Numerical Stabilization in the COMSOL Multiphysics Reference
ﬁl Manual

Wall Heat Transfer

Use the Wall Heat Transfer node to set up heat exchange across the pipe wall. Define
the external temperature and the nature of the heat transfer. The Internal Film
Resistance, Wall Layer, and External Film Resistance subnodes are available from the
context menu (right-click the parent node) or from the Physics toolbar, Attributes
menu. These compute heat transfer coefficients based on the section Theory for the

Heat Transfer in Pipes Interface.

You must add at least an Internal Film Resistance subnode. This
corresponds to a drilled channel in a solid. If a pipe wall exists, (
embedded in a solid), add also Wall Layer. If the pipe wall has more than

[

one layer, add more Wall Layer features. If the pipe exchanges heat to a
surrounding fluid by forced or natural convection, add also External Film
Resistance.

Internal film External film
4 [ Wall Heat Transfer 1 -

(= Internal Film Resistance 1
(= Steel pipe wall

[EY Insulation layer

(= External Filrm Resistance 1

Wall Iayers/

Figure 3-1: Internal and external films and the associated film coefficients (blue), and
wall layers (davk and light gray).

HEAT TRANSFER MODEL

Select an option from the External temperature list—User defined, or Temperature
(ht/ht), the latter representing a temperature field calculated by a surrounding 3D solid
physics. For User defined enter a value for the External Temperature T, (SI unit: K). If

an expression is used for T,,; that is a locally defined variable on the edge, the check

box Take average in adjacent domain should be cleared.
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Internal Film Resistance

The Internal Film Resistance subnode is available from the context menu (right-click the
Wall Heat Transfer parent node) or from the Physics toolbar, Attributes menu. Use it

to define the film resistance.

Even if you do not expect a boundary layer to build up, the thermal film
. theory works well for laminar flow profiles. In fact, there is an analytical
|_i| solution available to the Nusselt number for laminar flow in circular tubes

(Nu = 3.66).

FILM RESISTANCE

The default Internal film resistance model is Automatic and the Nusselt number is
computed as described in the section Theory for the Heat Transfer in Pipes Interface.
For User defined enter a value for the Nusselt number (dimensionless). The default is
3.66.

External Film Resistance

The External Film Resistance subnode is available from the context menu (right-click
the Wall Heat Transfer parent node) or from the Physics toolbar, Attributes menu. Use
it to define the external film resistance features including the material, thermal
conductivity, density, external velocity, and pressure of the external fluid. You can select

between forced and natural convection.

SPECIFICATION
Select an External film heat transfer model—External forced convection (the default),

External natural convection, or User defined.

External Forced Convection and External Natural Convection
For External forced convection or External natural convection the Surrounding fluid uses

the Domain material by default.

Be careful to select the right material in the Settings window for External
.& Film Resistance. Many times this should be another material than the

Domain material which is the internal fluid.

THE HEAT TRANSFER IN PIPES INTERFACE
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The default Heat capacity at constant pressure Cp (ST unit: J/(kg-K)), Thermal
conductivity % (ST unit: W/(m-K)), Density p (SI unit: kg/ms), and Dynamic viscosity
4 (ST unit: Pa-s), all use values From material. For User defined enter different values or

expressions than the default, which is 0 for all options.

The External velocity u,,; (SI unit: m/s) is User defined by default. This is the velocity
of the cooling or heating fluid outside the pipe.

For External natural convection only, also enter a value or expression for the External
pressure p,,; (SI unit: Pa). The default is 1 atm.

The natural convection correlations (see External film resistance) require
a temperature dependent density, or else the coefficient of thermal

expansion B evaluates to 0 (Equation 3-26), which might generate

L

unexpected results or even unstable models. Also, make sure that the
density correlation p(T') is smooth throughout the temperature interval

used, or else B is discontinuous and can cause numerical instability.

CHAPTER 3:

4 558 Materials rho(1.01e5,T)

4 528 Crude oil (matl) 1250
2= Basic (def) 1241

- 123

A 553 Air (matZ) 1550
4 528 Basic (def) 121F

. Piecewise (eta) 111';7

"\ Piecewise 2 (Cp) 118t

8 Analytic (rho) 117y

116
115+
1.14-
113
112+
111~

280 290 300 310 320

Figure 3-2: Before you use the Natural Convection option, it is good practice to select
Density in the used material, and click Plot in the Settings window. That way you can
inspect the behavior and make sure it is smooth within the temperaturve interval you plan
to use it.

User Defined
For User defined:

¢ Enter the Nusselt number (dimensionless). The default is 3.66.

¢ The Surrounding fluid uses the Domain material by default.
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¢ The Thermal conductivity 2 (ST unit: W/(m-K)) takes its value From material. For
User defined enter a different value or expression. The default is 0 W/ (m-K).

¢ Enter a value or expression for the External pressure p,,; (SI unit: Pa). The default

is 1 atm).

Wall Layer

The Wall Layer subnode is available from the context menu (right-click the Wall Heat
Transfer parent node) or from the Physics toolbar, Attributes menu. Use it to define the

thermal conductivity and wall thickness. You can add more layers.

SPECIFICATION
Select an option from the Thermal conductivity list £ (ST unit: W/(m-K))—Not set (the

default) or User defined to enter a different value or expression. The default is
0 W/(m-K).

Select an option from the Wall thickness list Aw (SI unit: m)—Net set (the default) or

User defined. For User defined enter a value or expression. The default is 0 m.

Initinl Values

The Initial Values node adds an initial value for the temperature that can serve as an

initial condition for a transient simulation or as an initial guess for a nonlinear solver.

INITIAL VALUES

Enter values or expressions for the initial value of the Temperature 7' (SI unit: K).

Temperature

Use the Temperature node to specify the temperature at an inlet of the pipe system.

TEMPERATURE
The equation for this condition is T = Ty where Ty is the prescribed temperature

(ST unit: K) on the boundary. Enter the value or expression for the Temperature T;,.
The default is 293.15 K.

CONSTRAINT SETTINGS
To display this section, click the Show button (“& ) and select Advanced Physics Options.

THE HEAT TRANSFER IN PIPES INTERFACE

71



Heat Outflow

The Heat Outflow node provides a suitable boundary condition for
convection-dominated heat transfer at outlet boundaries. In a model with convective
heat transfer, this condition states that the only heat transfer over a boundary is by
convection. The temperature gradient in the normal direction is zero, and there is no
radiation. This is usually a good approximation of the conditions at an outlet boundary
in a heat transfer model with fluid flow.
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Theory for the Heat Transfer in Pipes
Interface

The Heat Transfer in Pipes Interface and The Reacting Pipe Flow Interface theory is

described in this section:

e The Heat Transfer Equation

* Reference for the Heat Transfer in Pipes Interface

The Heat Transfer Equation

This physics interface solves an energy balance equation for 1D pipes, taking the flow

velocity as input.

HEAT BALANCE EQUATION
The energy equation for an incompressible fluid flowing in a pipe is (Ref. 24):

oac T

VT =V. pA 8 ]
oFT +pAC,u-VT = V AkVT+fD2dh|u\ +Q+ Q@ +Q, (B

where p is the fluid density (SI unit: kg/ m‘?’), A is the pipe cross section area

(ST unit: mz) available for flow, C,, (SI unit: ] /(kg-K)) is the heat capacity at constant
pressure, T' (SI unit: K) is the temperature. u is a velocity field. For information about
the tangential velocity in pipe flow, see Theory for the Pipe Flow Interface. Further, £
(ST unit: W/(m-K)) is the thermal conductivity. The second term on the right hand
side corresponds to friction heat dissipated due to viscous shear. @ (SI unit: W/m)
represents a general heat source and @,y (SI unit: W/m) represents external heat

exchange through the pipe wall. Note that the @4y term is detailed below.

An additional term @, can be added to the right-hand side of the equation by enabling
the Pressure Work check box:

o, T4

A% (a_p tu. Vp) (3-2)

oT

This term is optional and can be used if the pressure drop is expected to be

considerable and the fluid is compressible. The contribution follows the same theory
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as the pressure work term described in the section Flow Heating in the Heat Transfer
Module User’s Guide.

Wall Heat Transfer
The radial heat transfer from the surroundings into the pipe is given by

Qwall = (hz)cff(Tcxt_T) (W/m) (3-3)

In Equation 3-3, (hZ)eris an effective value of the heat transfer coefficient A
(SI unit: W/ (m2 -K)) times the wall perimeter Z (SI unit: m) of the pipe. Toy
(SI unit: K) the external temperature outside of the pipe. See Figure 3-3. Qa1 appears

as a source term in the pipe heat transfer equation, Equation 3-1.

The Wall Heat Transfer feature requires the external temperature and at least an
internal film resistance subnode added to it. The individual contributions of heat
transfer coefficients can be added by subnodes to the Wall Heat Transfer feature. The

subnodes are:

¢ Internal Film Resistance
e Wall Layer

¢ External Film Resistance

Tyt in Equation 3-3 can be a constant, parameter, expression, or given by a
temperature field computed by another physics interface, typically a 3D Heat Transfer
interface. A is automatically calculated through film resistances and wall layers that are

added as subnodes, see Equation 3-17 an on.

If Tyt is given as the temperature field computed by another 3D Heat Transfer
interface, automatic heat transfer coupling is done to the 3D physics side as a line
source. The temperature coupling between the pipe and the surrounding domain is
implemented as a line heat source in the 3D domain. The source strength is
proportional to the temperature difference (Equation 3-3) between the pipe fluid and

the surrounding domain.
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The overall heat transfer coefficient including internal film resistance, wall resistance

and external film resistance can be deduced as follows, with reference to Figure 3-3.

Layered pipe wall

T

[
Fluid domain T Ty Ty
\ Ty T
[l . &
N M r
ext

Wall number: III 2|n| N !
| -

T
ro r

Figure 3-3: Temperature distribution across the pipe wall

* rp (ST unit: m) is the outer radius of wall n

e w=r—-rg(SIunit: m) a wall coordinate, starting at the inner radius ry
* Aw, =r, —ry_q (ST unit: m) the wall thickness of wall n

e Z, (ST unit: m) is the outer perimeter of wall n

* hint and Agyg are the film heat transfer coefficients on the inside and outside of the
tube, respectively (SI unit: W/ (m2 -K)).

* ks the thermal conductivity (SI unit: W/(m-K)) of wall n

Shell balance In Figure 3-3, consider a short length section AL of pipe, perpendicular

to the figure plane. The heat leaving the internal fluid of that segment into the wall is
QO = hmtAQ : (T— T()) (W) (3-4)

Here, Ag= AL2mr( (SI unit: m2) is the area available for heat flux into the wall. For
stationary conditions that same amount of heat must travel through any cylindrical

shell at radius 7 in wall 1 (or any wall).

Q, = sz (-1, 4L) (3-5)
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Rearrange and integrate from r to ry.

T

To

1 Q 1
Jar = -J(szzm; 7)ar (3-6)
T, ro
Perform the integration
Q r
Tl_TO = _AL2—TEkl . ln(;—) (3-7)
and rearrange
_ AL27k, T T
1= (Ty-T9). (3-8)

For the example of two wall layers, the heat flow is equal across any shell from the inner
bulk fluid to the surroundings, and we can setall @ = Q.

Q = hy AL21r,- (T-T,)

- ey o Ty
ALZITEkZ @9
= m (T,-Ty)
Q=nh AL2nry - (Ty-T,,)
Substituting
0 = AL2n, (3-10)
and making a linear combination of the equations Equation 3-9 gives
Q = (hAg) 4 (T-T.) (3-11)
where (hAg)efy is an effective conductance:
(hAg) = 1 (3-12)

1 . In(ry/ry) . In(ry/ry) . 1
rohim(a k0 kO roh ©

ext

For the general case with NV wall layers this reads
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(hAQ)Cff = p (3-13)
N (in(-2)
1 Th-1 1
rohim(a Z k.© ryh O
Now let
(hAQ)cff
(hZ) g4 = L (8-14)

where Z (ST unit: m) is an average perimeter (circumference), of the pipe, taken over
the thickness of the pipe walls. Combine Equation 3-10 and Equation 3-14 such a that

(hAQ)cﬂc = (hZ) 49/(2m)
and insert in Equation 3-13:

2n
)

nI
ot
n=1

(hZ)ctf =

(3-15)

1
roh.

int N ext

For a circular pipe cross sections, this effective 2Z in can now be used in Equation 3-3.
Note the reversed sign since Q411 is the heat added to the pipe from the surroundings.

The assumption in the deduction above is

¢ cqual temperature around the circumference of the

¢ the heat transfer through the wall is quasi-static. The latter means that the wall is
assumed to immediately assume the equilibrium temperature distribution
corresponding to T and Ty If this assumption would not be made, an auxiliary
PDE across the wall coordinate would be required.

For square and rectangular pipe shapes the average conductance can be approximated
by the simpler sum of resistances across a plane wall, which can be found in for example
(Ref. 13):

(hZ) g = (3-16)

Zoh " zk ((Z 7%

mnt
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The film resistances can be calculated from

h = NuX

a, (3-17)

where £ is the thermal conductivity of the material, and Nu is the Nusselt number. dj,
is the hydraulic diameter, defined as

d, = 4A/Z. (3-18)

e The inner and outer film coefficients is evaluated at (T'+ T)/2 and (T’ + Text)/2,
respectively.

¢ The thermal conductivity &, can be temperature dependent and is evaluated at
T+ Th_p)2.

¢ To compute dy, in Equation 3-18 the local perimeter is calculated as Z = fiw) and
the cross section area as A = fiw). Automatic calculations for circular tubes are done
by the physics interface as Z = 2nr and A = nr2. For rectangular tubes it is
Z = 2(width + height) and A = width - height. For user-defined pipe shapes, the user
can enter arbitrary expressions.

The local temperatures in each radial position of the pipe wall (see Figure 3-3) are
computed considering the fact that Equation 3-3 also can be applied for each
individual wall layer:

Qwall = (hz)eﬂf(Tm-l - Tn) (3-19)

Combining Equation 3-3, Equation 3-19 and Equation 3-15 or Equation 3-16
(depending on pipe shape) for each wall layer explicitly gives each T,.

Internal Film Resistance For internal laminar forced convection in fully developed
pipe flow, the Nusselt number is a constant that depends on the pipe cross-section.
Values are listed in the table below (Ref. 1). The Pipe Flow interface interpolates to
find values for width /height ratios not listed. Default settings for film coefficient
calculations are “Automatic”, which means that laminar and turbulent correlations are
applied according to the Re number.

TABLE 3-1: NUSSELT NUMBERS FOR INTERNAL LAMINAR PIPE FLOW

CROSS SECTION WIDTH/HEIGHT NU

circular - 3.66
square | 298
rectangular 1.43 3.08
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TABLE 3-1: NUSSELT NUMBERS FOR INTERNAL LAMINAR PIPE FLOW

CROSS SECTION WIDTH/HEIGHT NU

rectangular 2 3.39
rectangular 3 3.96
rectangular 4 4.44
rectangular 8 5.60
parallel plates infinity 7.54

For user-defined cross sections, Nu is suggested to 3.66 as a default.

For internal turbulent forced convection (3000 < Re < 6~1()6, 0.5 < Pr < 2000), the
Gnicelinski equation (Ref. 18) applies:

(f/8)(Re — 1000)Pr

Nu. . = (3-20)
" e 27¢,8) 2@ - 1)
Where Pr is the Prandtl number:
C
pr = %” (3-21)

The film resistance due in the internal flow can be calculated using material properties
defined in the Heat Transfer feature and the calculated friction factor. Material
properties are evaluated at the mean internal film temperature (T + T)/2 (see

Expressions for the Darcy Friction Factor).

The using the hydraulic diameter makes the equations applicable to non-circular pipe

cross sections.

External film resistance The material properties used should be those of the external
fluid. Do not set the material to Domain Material if you have a different fluid on the
inside and outside. Typically, the temperature and pressure are required to evaluate the
material functions. The external fluid velocity is required for the Forced Convection

option and is a user-defined input.

For External forced convection around a pipe, valid for all Re and for Pr > 0.2, the

Churchill and Bernstein (Ref. 19) correlation is used:

1/2 1/3
_ 034+ —202Re Pr . pe/282000)

5/8]4/5
1/4 :
[1+(04/Pr)>"

Nu (3-22)

ext
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For External natural convection around a pipe, the Churchill and Chu (Ref. 20)

correlation is used which is recommend for Ra < 1012

1/6 2
Nu, = {0.60 N 0.387Ra } (3-23)
9/16.87/27
[1+(0.559/Pr)”" 7]
where the Rayleigh number is given by:
Ra = PrGr (3-24)
and the Grashof number is:
gB| Ty - Tord’
Gr = ———=— (3-25)
5
p
Above d is the outside diameter of the pipe and, B is the fluid’s coefficient of
volumetric thermal expansion:
- _1(9p -
= 020

Material properties are evaluated at (T + T'ext)/2.

STABILIZATION OF THE HEAT TRANSFER EQUATION

The transport equation in the Heat Transfer in Pipes interface is numerically stabilized.

Numerical Stabilization in the COMSOL Multiphysics Reference
{‘i Mannal

CHAPTER 3:

Reference for the Heat Transfer in Pipes Interfuce

1. E.P. Incropera and D.P. DeWitt, Fundamentals of Heat and Mass Transfer, 4th
ed., John Wiley & Sons, 1996.
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Chemical Species Transport Interfaces

This chapter has information about the physics interfaces found under the

Chemical Species Transport branch ( #:2).
In this chapter:
* The Transport of Diluted Species in Pipes Interface

¢ The Reacting Pipe Flow Interface
e Theory for the Transport of Diluted Species in Pipes Interface
See The Transport of Diluted Species Interface in the COMSOL Multiphysics

Reference Mannal for other Chemical Species Transport interface and feature

node settings.
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The Transport of Diluted Species in
Pipes Interface

The Transport of Diluted Species in Pipes (dsp) interface (= ), found under the Chemical

Species Transport branch ( 32 ) when adding a physics interface, is used to model a mass
balance equation for Pipes in order to compute the concentration distribution of a
solute in a dilute solution, taking into account diffusion, dispersion, convection, and
chemical reactions. The physics interface approximates the concentration profile in
Pipes and channels by a 1D assumption on lines in 2D and 3D. Depending on

additional add-on products, multiple species can be modeled.

When this physics interface is added, these default nodes are also added to the Model
Builder—Convection and Diffusion, Concentration, and Initial Values. Then, from the
Physics toolbar, add other nodes that implement, for example, boundary conditions
and volume forces. You can also right-click Transport of Diluted Species in Pipes to sclect

physics features from the context menu.

The Reacting Pipe Flow Interface node uses this physics interface and couples it

automatically to Pipe Flow and Heat Transfer in Pipes.

SETTINGS

The Label is the default physics interface name.

The Name is used primarily as a scope prefix for variables defined by the physics
interface. Refer to such physics interface variables in expressions using the pattern
<name>.<variable_name>. In order to distinguish between variables belonging to
different physics interfaces, the name string must be unique. Only letters, numbers and
underscores (_) are permitted in the Name field. The first character must be a letter.

The default Name (for the first physics interface in the model) is dsp.

FLUID MODEL

Select a Fluid model—Newtonian (the default), Power law, or Bingham.

DEPENDENT VARIABLES
This physics interface defines these dependent variables (fields)—Number of

concentrations ¢ (SI unit: mol/ms) and Concentrations.
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If required, edit the name, but dependent variables must be unique within a model:

To enable multiple species (more than one concentration), you need a
license for one of these modules: Batteries & Fuel Cells Module, CED
Module, Chemical Reaction Engineering Module, Corrosion Module,

I

Electrodeposition Module, Microfluidics Module, or the Subsurface
Flow Module.

DISCRETIZATION

To display this section, click the Show button (& ) and select Discretization.

* Edge, Boundary, Point, and Pair Nodes for the Transport of Diluted
@L Species in Pipes Interface

e Theory for the Transport of Diluted Species in Pipes Interface

Edge, Boundary, Point, and Pair Nodes for the Transport of Diluted
Species in Pipes Interface

The Transport of Diluted Species in Pipes Interface has these boundary, edge, point,
and pair nodes available from the Physics ribbon toolbar (Windows users), Physics
context menu (Mac or Linux users), or right-click to access the context menu (all
users).:

In general, to add a node, go to the Physics toolbar, no matter what
'g' operating system you are using. Subnodes are available by clicking the

parent node and selecting it from the Attributes menu.

* Concentration * Pipe Properties
¢ Convection and Diffusion e Reactions
e Initial Values e Wall Mass Transfer

e Mass Outflow
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In the COMSOL Multiphysics Refevence Manual see Table 2-3 for links
to common sections and Table 2-4 to common feature nodes. You can
n also search for information: press F1 to open the Help window or Ctrl+F1

to open the Documentation window.

Convection and Diffusion

Use the Convection and Diffusion node to define the fluid properties, velocity, diffusion
coefficient, and dispersion model. This node as present by default.

FLUID PROPERTIES
The default Density o (SI unit: kg/ms) uses the value From material. For User defined

enter a different value or expression.

The default Dynamic viscosity # (SI unit: Pa-s) uses the value From material and
describes the relationship between the shear rate and the shear stresses in a fluid.
Intuitively, water and air have a low viscosity, and substances often described as thick,

such as oil, have a higher viscosity.

VELOCITY
Enter a value or expression for the Tangential velocity u (SI unit: m? /s). The default
is 0 m? /s.

DIFFUSION COEFFICIENT
Enter a value or expression for the diffusion coefficient D, (SI unit: m? /s). The default
is 1102 m2/s.

DISPERSION

Select a Dispersion model—User defined (the default), Taylor (laminar, circular cross
section), or Taylor (turbulent, circular cross section). For User defined enter a value or
expression for the Dispersion coefficient Dpy (SI unit: mz/s). The default is 0 mz/s.
Find more detail in the theory section Dispersion.

Initial Values

The Initial Values node adds an initial value for the concentration that can serve as an

initial condition for a transient simulation or as an initial guess for a nonlinear solver.
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INITIAL VALUES

Enter values or expressions for the initial value of the Concentration ¢
(ST unit: mol/ms). The default is 0 mol/ms.
Reactions

Use the Reactions node to account for the consumption or production of species.
Define the reaction rate expression as needed, which displays on the right-hand side of

the species transport equations in the Convection and Diffusion node.

REACTIONS
Enter a Reaction rate R, (SI unit: mol/(ms-s)). The default is 0 mol/(ms-s).

Wall Mass Transfer

Use the Wall Mass Transfer node to model species loss to the surroundings of the pipe.
This could be used if the diluted species is soluble in the pipe wall or if the pipe wall is
semipermeable. A mass transfer coefficient is used to model the loss rate, and external

bulk concentration i specified to define the driving force.

WALL MASS TRANSFER

For each species, enter a Mass transfer coefficient k,,,;; . (ST unit: m/s). The default is
0 m/s. For each species, select an option from the list (when available) or define the
Bulk concentration cp,,;;, (SI unit: mol/ms). The defaultis 0 mol/ms.

Concentration

The Concentration node adds a point condition for the species concentration. For

example, a ¢ = ¢( condition specifies the concentration of species c.

CONCENTRATION
Specify the Concentration c;;,. (SI unit: mol/(ms-s)) for each species. Enter a value or

expression in the field for each species. The default is 0 mol/ (mg-s).

CONSTRAINT SETTINGS
To display this section, click the Show button (“& ) and select Advanced Physics Options.
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Mass Outflow

Use the Mass Outflow node to define species mass outflow. Mathematically this is
defined so that convection is the sole contribution to species mass transfer. Normally

this constitutes a well posed condition for all outflows.

86 | CHAPTER 4: CHEMICAL SPECIES TRANSPORT INTERFACES



The Reacting Pipe Flow Interface

The Reacting Pipe Flow (rpfl) interface (=g ), found under the Chemical Species
Transport branch ( ;2 ) when adding a physics interface, is a multiphysics interface that
combines the three physics interfaces: Pipe Flow, Heat Transfer in Pipes, and Transport
of Diluted Species in Pipes. The physics interface approximates the flow profiles in
Pipes and channels by a 1D assumption on lines in 2D and 3D. Depending on

additional add-on products, multiple species can be modeled.

When this physics interface is added, these default nodes are also added to the Model
Builder—Fluid, Pipe Properties, Temperature, Pressure, Concentration, and Initial Values.
Then, from the Physics toolbar, add other nodes that implement, for example,

boundary conditions and volume forces. You can also right-click Reacting Pipe Flow to

select physics features from the context menu.

SETTINGS

The Label is the default physics interface name.

The Name is used primarily as a scope prefix for variables defined by the physics
interface. Refer to such physics interface variables in expressions using the pattern
<name>.<variable_name>. In order to distinguish between variables belonging to
different physics interfaces, the name string must be unique. Only letters, numbers and

underscores (_) are permitted in the Name field. The first character must be a letter.
The default Name (for the first physics interface in the model) is rpf1.

FLUID MODEL

Select a Fluid model—Newtonian (the default), Power law, or Bingham.

PHYSICAL MODEL

Enter a Reference pressure level p,..¢ (SI unit: Pa). The default value is 1[atm].

DEPENDENT VARIABLES
This physics interface defines these dependent variables (fields). If required, edit the

name, but dependent variables must be unique within a model:

* Pressure p (SI unit: Pa)

* Tangential velocity u (SI unit: m/s)
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¢ Temperature T (SI unit: K)

* Concentration ¢ (SI unit: mol/ms)

DISCRETIZATION

To display this section, click the Show button ("& ) and select Discretization.

e The Pipe Flow Interface
e The Heat Transfer in Pipes Interface
ﬁl * The Transport of Diluted Species in Pipes Interface

* Edge, Boundary, Point, and Pair Nodes for the Reacting Pipe Flow
Interface

Edge, Boundary, Point, and Pair Nodes for the Reacting Pipe Flow
Interface

The Reacting Pipe Flow Interface has these boundary, edge, point, and pair nodes
available from the Physics ribbon toolbar (Windows users), Physics context menu (Mac

or Linux users), or right-click to access the context menu (all users).

In general, to add a node, go to the Physics toolbar, no matter what
'g' operating system you are using. Subnodes are available by clicking the

parent node and selecting it from the Attributes menu.

These nodes are described in this section:

* Initial Values ¢ Fluid Properties
* Convection and Diffusion * Properties
e Fluid
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These nodes are described for the Pipe Flow interface (listed in alphabetical order):

* Bend ¢ Pipe Connection
* Contraction / Expansion e Pressure

e Inlet e Pump

¢ No Flow e T-Junction

* Outlet e Valve

¢ Phase Fractions ¢ Volume Force

These nodes are described for the Heat Transfer in Pipes interface (listed in

alphabetical order):

e External Film Resistance ¢ Internal Film Resistance
* Heat Outflow * Temperature

e Heat Source e Wall Heat Transfer

e Heat Transfer * Wall Layer

These nodes are described for the Transport of Diluted Species in Pipes interface
(listed in alphabetical order):

* Concentration

e Mass Outflow

¢ Reactions

¢ Wall Mass Transfer

In the COMSOL Multiphysics Refevence Manual see Table 2-3 for links
to common sections and Table 2-4 to common feature nodes. You can
n also search for information: press F1 to open the Help window or Ctrl+F1

to open the Documentation window.

Properties

The Pipe Properties node is used to define the pipe shape and flow resistance.
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SHAPE
The Pipe Shape settings are the same as for the Pipe Properties node described for the

Pipe Flow interface.

FLOW RESISTANCE
The Friction model is User defined by default. Enter a value or expression for the Darcy

friction factor fy (dimensionless). The default is 0.

Initial Values

The Initial Values node adds initial values for the pressure, tangential velocity,
temperature, and concentration that can serve as an initial condition for a transient

simulation or as an initial guess for a nonlinear solver.

INITIAL VALUES

Enter values or expressions for the initial value of the:

* Pressure p (SI unit: Pa). The default is 101325 Pa.

¢ Tangential velocity u (SI unit: m/s). The default is 0 m/s.
e Temperature T (SI unit: K). The default is 293.15 K.

¢ Concentration ¢ (SI unit: mol/ms). The default is 0 mol/m‘?’.

Fluid

Use the Fluid node to define the density, dynamic viscosity, and heat convection and

conduction properties.

FLUID PROPERTIES
The default Density o (SI unit: kg/m3) uses the value From material. For User defined

enter a different value or expression.

The default Dynamic viscosity £ (SI unit: Pa-s) uses the value From material and
describes the relationship between the shear rate and the shear stresses in a fluid.
Intuitively, water and air have a low viscosity, and substances often described as thick,

such as oil, have a higher viscosity.

DIFFUSION COEFFICIENT
Enter a value or expression for D, (SI unit: mz/s). The default is 1.107 mz/s.
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DISPERSION

Sclect a Dispersion model—User defined (the default), Taylor (laminar, circular cross
section), or Taylor (turbulent, circular cross section). For User defined enter a value or
expression for the Dispersion coefficient Dpy (SI unit: mz/s), The defaultis 0 mz/s, For
detailed information about dispersion, see the theory section Dispersion.

HEAT CONVECTION AND CONDUCTION

The default Heat capacity at constant pressure C), (SI unit: J/(kg-K)), Ratio of specific
heats Y (dimensionless), and Thermal conductivity % (SI unit: W/(m-K)) all use values

From material. For User defined enter different values or expressions.

Fluid Properties

The Fluid Properties node adds the momentum equations solved by the physics
interface, except for volume forces which are added by the Volume Force feature. The

node also provides an interface for defining the fluid properties of the fluid.

FLUID PROPERTIES
The default Density o (SI unit: kg/mg) is User defined and is 1.103 kg/ms.

The fluid model is selected as non-Newtonian, enter a value or expression for the more

parameters like Yield stress 7, (SI unit: Pa) and Plastic viscosity 4, (SI unit: Pa-s).

Convection and Diffusion

Use the Convection and Diffusion node to define the fluid properties, velocity, diffusion

coefficient, and dispersion model. This node is present by default.

FLUID PROPERTIES
The default Density o (SI unit: kg/ms) is User defined and is 1.10° kg/ms.

Enter a value or expression for the Yield stress 7, (SI unit: Pa) and Plastic viscosity

(SI unit: Pa-s). The defaults are 0 Pa and 0 Pa-s, respectively.

VELOCITY

No user selection is required for the Tangential velocity .

DIFFUSION COEFFICIENT

Enter a value or expression for the diffusion coefficient D, (SI unit: m? /s). The default
is1.107° mz/s.
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DISPERSION

Select a Dispersion model—User defined (the default) or Fan (laminar, circular cross
section). For User defined enter a value or expression for the Dispersion coefficient Dy
(ST unit: mz/s). The default is 0. For detailed information about dispersion, see the
theory section Dispersion.
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Theory for the Transport of Diluted
Species in Pipes Interface

The Transport of Diluted Species in Pipes Interface theory is described in this section.
This physics interface solves a mass balance equation for Pipes in order to compute the
concentration distribution of a solute in a dilute solution, taking the flow velocity as

input.

MASS CONSERVATION EQUATION
The mass transport equation for a diluted species z an incompressible fluid flowing in
a pipe is:
dc;
Aﬁ +Au-Ve; = V- (AD; + Dp ;)Vc;) +A2Rik + szall, ik (4-1)
k k

where A (ST unit: m? ) is the cross section area available for flow, ¢; (SI unit: mol/ ms)
is the diluted species concentration, and u a velocity field. Further, D; (SI unit: m? /s)
is the species diftusion coefficient and Dp, ; (SI unit: m? /s) is the species dispersion
coefficient. The second term on the right hand side, R;;, (SI unit: mol/(m3-s)),
corresponds a source or sink due to chemical reaction number % for species i. Finally,
Ryyq1i% (S unit: mol/(m-s)), is a source term due to mass transfer contribution %
through the pipe wall.

For information about tangential velocity in pipe flow, see Theory for the
la Pipe Flow Interface.

Dispersion
The Transport of Diluted Species in Pipes interface can automatically calculate the axial

dispersion of species transported in a solvent stream.

For laminar flow in circular straight pipes, the total dispersion is given by the sum of
molecular diffusion, D; (SI unit: m“/s), and the effect of the velocity profile causing
some fractions of an initial plane of fluid in the pipe to move faster than others.
COMSOL Multiphysics uses the Taylor (Ref. 21) correlation for this second
contribution, Dp ; (SI unit: mz/s):
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2,2
u'd

Di = 192D, “-2)
This expression is valid if:

L ud

3> 0.04-17 (4-3)

13

where d is the pipe diameter and L a characteristic pipe length. For turbulent
conditions Taylor (Ref. 22) suggests:

1019, o
Dp; = 10.12u£- (4-4)

For non-Newtonian fluids in the laminar regime Fan (Ref. 23) extended the analysis

of Taylor:
2 42
d
Dp; = k- (4-5)
b.i =" 4D,
with & for Power-law fluids given by:
1 (4-6)

k= 2(n+3)(n+5)
and % for Bingham plastic fluids:

3 44 16,2 4 285 3.6 8,7 29,8 1,10 .8
. (5 5500 7300+ 90~ 1500 360 + 00~ 5500+ 300’ - 94 noy) wn
- _ .
2(3 + 200+ 0g) (1-09)*

The parameter ¢ is

_ o

% =3 (4-8)

where R is the pipe radius and 7 is the radius of the plug flow region in the plastic

flow, defined as

2L7g
r =
0 Ap

(4-9)

This can be rewritten as
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4
0p = ——Bm (4-10)
dlv'pl

where the tangential pressure gradient is calculated by the Pipe Flow interface.

STABILIZATION OF THE MASS TRANSFER EQUATION
The transport equation in the Transport of Diluted Species in Pipes node is
numerically stabilized.

Numerical Stabilization in the COMSOL Multiphysics Reference
@ Manual
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Acoustics Interfaces

This module has extra functionality for simulating acoustics in pipe networks,
which is found under the Acoustics>Acoustic-Structure Interaction branch (&)
when adding a physics interface.

¢ The Pipe Acoustics Interfaces

e Theory for the Pipe Acoustics Interfaces

See the Acoustics Module User’s Guide for information about all other Acoustics

physics interfaces.

If you do not have the Acoustics Module, see The Pressure Acoustics, Frequency
Domain Interface in the COMSOL Multiphysics Refevence Manual for an

Acoustic physics interface and its feature node settings.
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The Pipe Acoustics Interfaces

In this section:

¢ The Pipe Acoustics, Frequency Domain Interface
* The Pipe Acoustics, Transient Interface

¢ For links to all the physics features, go to Edge, Boundary, Point, and Pair Nodes

for the Pipe Acoustics Interfaces

. These interfaces require both the Pipe Flow Module and the Acoustics
=] Module.

CHAPTER 5:

The Pipe Acoustics, Frequency Domain Interface

The Pipe Acoustics, Frequency Domain (pafd) interface ( () ), found under the
Acoustics>Acoustic-Structure Interaction branch ( ;j77) when adding a physics interface,
is used to compute the acoustic pressure and velocity variations when modeling the
propagation of sound waves in flexible pipe systems. The governing equations are
formulated in a general way to include the possibility of a stationary background flow.
The physics interface can for example be used to compute the propagation of sound

waves in HVAC systems, other large piping systems, or simply in an organ pipe.

In the frequency domain all sources and variations are assumed to be harmonic. The
solved equations assume that the propagating waves are plane. The propagation of
higher-order modes that exist above their cut-off frequency, dictated by the pipe cross

section, is not modeled.

The equations governing the propagation of sound in pipes stem from considering
momentum, mass, and energy balances for a control volume of a piece of pipe. The
resulting equations are expressed in the cross-sectional averaged variables and reduce
the equations to a 1D component with scalar dependent variables. The physics

interface is available in 3D on edges and points, and in 2D on boundaries and points.

When this physics interface is added, these default nodes are also added to the Model
Builder—Fluid Properties, Pipe Properties, Closed, and Initial Values. Then, from the
Physics toolbar, add other nodes that implement, for example, boundary conditions
and point conditions. You can also right-click Pipe Acoustics, Frequency Domain to select

physics features from the context menu.
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SETTINGS

The Label is the default physics interface name.

The Name is used primarily as a scope prefix for variables defined by the physics
interface. Refer to such physics interface variables in expressions using the pattern
<name>.<variable_name>. In order to distinguish between variables belonging to
different physics interfaces, the name string must be unique. Only letters, numbers, and

underscores (_) are permitted in the Name field. The first character must be a letter.

The default Name (for the first physics interface in the model) is pafd.

SOUND PRESSURE LEVEL SETTINGS
The zero level on the dB scale varies with the type of fluid. That value is a reference
pressure that corresponds to 0 dB. This variable occurs in calculations of the sound

pressure level L, based on the root mean square (rms) pressure prpyg, such that

Lp = ZOlog(ﬁ) with Prins = '%pp*

ref

where pqris the reference pressure and the star (*) represents the complex conjugate.
This is an expression valid for the case of harmonically time-varying acoustic

pressure p.
Select a Reference pressure for the sound pressure level based on the fluid type:
* Use reference pressure for air to use a reference pressure of 20 puPa (20~10_6 Pa).

* Use reference pressure for water to use a reference pressure of 1 uPa (1-10_6 Pa).

* User-defined reference pressure to enter a reference pressure prer gpr, (SI unit: Pa).
The default value is the same as for air, 20 uPa.

For postprocessing, plot the sound pressure level pafd.Lp, which
depends on the selected reference pressure. You can also plot the rms
=] intensity magnitude pafd.I_rms or the instantaneous intensity

magnitude pafd.I_inst.

DEPENDENT VARIABLES
This section is used to define the dependent variables (fields) for Pressure p
(ST unit: Pa) and Tangential velocity u (SI unit: m/s). If required, edit the name, but

dependent variables must be unique within a model.
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DISCRETIZATION
To display this section, click the Show button (“& ) and select Discretization. It controls

the element types used in the finite element formulation.

* Edge, Boundary, Point, and Pair Nodes for the Pipe Acoustics
.a Interfaces

e Theory for the Pipe Acoustics Interfaces

CHAPTER 5:

The Pipe Acoustics, Transient Interface

The Pipe Acoustics, Transient (patd) interface ( (i) ), found under the
Acoustics>Acoustic-Structure Interaction branch ( ;j77) when adding a physics interface,
is used to compute the acoustic pressure and velocity variations when modeling the
propagation of sound waves in flexible pipe systems. The governing equations are
formulated in a general way to include the possibility of a stationary background flow.
The physics interface can for example be used to compute the propagation of sound

waves in HVAC systems, other large piping systems, or simply in an organ pipe.

The solved equations assume that the propagating waves are plane. The propagation
of higher-order modes that exist above their cut-oft frequency, dictated by the pipe

cross section, is not modeled.

The equations governing the propagation of sound in pipes stem from considering
momentum, mass, and energy balances for a control volume of a piece of pipe. The
resulting equations are expressed in the cross-sectional averaged variables and reduce
the equations to a 1D component with scalar dependent variables. The physics

interface is available in 3D on edges and points, and in 2D on boundaries and points.

When this physics interface is added, these default nodes are also added to the Model
Builder—Fluid Properties, Pipe Properties, Closed, and Initial Values. Then, from the
Physics toolbar, add other nodes that implement, for example, boundary conditions
and point conditions. You can also right-click Pipe Acoustics, Transient to select physics
features from the context menu.

SETTINGS
The Label is the default physics interface name.

The Name is used primarily as a scope prefix for variables defined by the physics
interface. Refer to such physics interface variables in expressions using the pattern
<name>.<variable_name>. In order to distinguish between variables belonging to
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different physics interfaces, the name string must be unique. Only letters, numbers and

underscores (_) are permitted in the Name field. The first character must be a letter.

The default Name (for the first physics interface in the model) is patd.

TRANSIENT SOLVER SETTINGS

Select the Time stepping (method) as Manual (default and recommended) or Automatic/
free and then enter the Maximum frequency to resolve in the model. The default
frequency is set to 1000[Hz] but should be changed to reflect the frequency content
of the sources used in the model. The generated solver will be adequate in most
situations if the computational mesh also resolves the frequency content in the model.
Note that any changes made to these settings (after the model is solved the first time)
will only be reflected in the solver if Show Default Solver or Reset Solver to Defaults is

selected in the study.

The rest of the settings are the same as for The Pipe Acoustics, Frequency Domain

Interface.

¢ Edge, Boundary, Point, and Pair Nodes for the Pipe Acoustics
E}‘ Interfaces

e Theory for the Pipe Acoustics Interfaces

Edge, Boundary, Point, and Pair Nodes for the Pipe Acoustics
Interfaces

The Pipe Acoustics, Frequency Domain Interface and The Pipe Acoustics, Transient
Interface have these edge, boundary, point, and pair nodes, listed in alphabetical order,
available from the Physics ribbon toolbar (Windows users), Physics context menu (Mac
or Linux users), or right-click to access the context menu (all users).

In general, to add a node, go to the Physics toolbar, no matter what
'g' operating system you are using. Subnodes are available by clicking the

parent node and selecting it from the Attributes menu.
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¢ Closed * DPipe Properties

e End Impedance * Pressure
* Fluid Properties * Velocity
¢ Initial Values ¢ Volume Forceis described for the

Pipe Flow interface.

In the COMSOL Multiphysics Refervence Manual see Table 2-3 for links
to common sections and Table 2-4 to common feature nodes. You can
n also search for information: press F1 to open the Help window or Ctrl+F1

to open the Documentation window.

CHAPTER 5:

Initinl Values

The Initial Values node adds initial values for the pressure and tangential velocity that
can serve as an initial condition for a transient simulation or as an initial guess for a

nonlinear solver.

INITIAL VALUES
Enter values or expressions for the initial value of the Pressure p (ST unit: Pa) and the
Tangential Velocity © (SI unit: m/s).

Fluid Properties

The Fluid Properties node adds the momentum and continuity equations solved by the
physics interface, except for volume forces which are added by the Volume Force node.
The node also provides an interface for defining the material properties of the fluid.

MODEL INPUTS
Enter a value for the and Background mean flow pressure p( (SI unit: Pa). This pressure
will also serve as input the material parameters that depend on the pressure.

BACKGROUND VELOCITY

Enter a value or expression for the Background mean flow velocity u( (SI unit: m/s)

Physically sound background variables for the pressure pg and velocity u( can be
obtained by solving a Pipe Flow model on the same geometry.
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PHYSICAL PROPERTIES

Select a Fluid model—Linear elastic (the default).

The default Density o (SI unit: kg/ms) and Speed of sound c, (SI unit: m/s) use the

values From material. For User defined enter different values or expressions.

Pipe Properties

The Pipe Properties node is used to define the pipe shape, pipe model, wall drag force,

and flow profile correction factor.

PIPE SHAPE
Select a pipe shape from the list—Not set (the default), Circular, Square, Rectangular, or
User defined.

* For Circular enter a value or expression for the Inner diameter d; (SI unit: m). The
default is 10 cm (0.01 m).

* For Square enter a value or expression for the Inner width w; (SI unit: m). The
default is 5 cm (0.005 m).

* For Rectangular enter a value or expression for the Inner width w; (SI unit: m; the
default is 5 cm) and Inner height A; (SI unit: m; the default is 10 cm).

* For User defined enter a value or expression for the Cross sectional area A (SI unit:
m? ; the default is 0.01 m? ) and Wetted perimeter Z (SI unit: m; the default is
0.4 m).

PIPE MODEL
Select a Pipe model—Incompressible cross section (the default), Zero axial stress,

Anchored at one end, or Anchored at both ends.

When Zero axial stress, Anchored at one end, or Anchored at both ends is chosen, select
an option from the Young’s modulus E (SI unit: Pa) and Wall thickness A w lists—Not
set (the default) or User defined. For User defined in cither case, enter different values

or expressions.

For Anchored at one end or Anchored at both ends also sclect an option from the
Poisson’s ratio v (dimensionless) list—Not set (the default) or User defined. For User

defined enter a value or expression.

WALL DRAG FORCE
Enter a value or expression for 7 (SI unit: N/ mz). The defaultis 0 N/ m?>.

THE PIPE ACOUSTICS INTERFACES
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FLOW PROFILE CORRECTION FACTOR

Enter a value or expression for B (dimensionless). The default is 1. For most practical
applications this correction factor is 1 as the propagating waves are assumed plane and
uniform. This value should typically be changed it a wall drag force is introduces or if
a non-plug-flow background flow field is used. The flow profile correction factor is
defined as

~ ~ 9 ~ ~ 2
B = U(u +u,) dA)/(J'(u + uo)dA)
where the velocity field is the actual one that exists in the pipe cross section. The factor

thus measures the deviation from a flat background flow profile (plug flow) and a plane

propagating acoustic wave.

@t Flow Profile Correction Factor b

Closed

Use the Closed node to impose zero velocity. This is the default condition added on all

end points.

ﬂ Theory for the Pipe Acoustics Boundary Conditions

CHAPTER 5:

Pressure

Use the Pressure node to define the boundary pressure at the pipe ends.

PRESSURE

Enter a value or expression for the Pressure p (SI unit: Pa). The default is 0 Pa.

In the frequency domain p represents the amplitude and phase (if it is complex valued)

of a harmonic pressure source.

In the time domain enter an expression for the pressure p, for example, a forward
moving sinusoidal wave of amplitude 1 Pa can be written as
1[Pa]l*sin(omega*t-k*x), where omega and k are parameters defining the angular

frequency and wave number.
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CONSTRAINT SETTINGS
To display this section, click the Show button (“& ) and select Advanced Physics Options.

{E}‘ Theory for the Pipe Acoustics Boundary Conditions

Velocity

Use the Velocity node to prescribe a velocity at the pipe ends.

VELOCITY

Enter a value or expression for the velocity u;, (SIunit: m/s) at the inlet and /or outlet
of'a pipe. The default is 0 m/s. The velocity u;;, is defined relative to background flow
uq and thus in the tangential coordinate system. Enable the Show physics symbols from
the Graphics and Plot Windows menu on the Preference dialog box in order to visualize
the boundary or edge tangent direction. Click the Fluid Properties node to see the

tangents as a red arrows.

* Theory for the Pipe Acoustics Interfaces

{i}‘ e The Preferences Dialog Box in the COMSOL Multiphysics Reference
Guide
End Impedance

Use the End Impedance node to model conditions at the end of a pipe. The condition
can either model an infinite pipe and thus represent the characteristic impedance of the
pipe system at that point. This results in a zero reflection condition. Alternatively the
condition can represent the radiation impedance of an open pipe in either a flanged (in

an infinite baffle) or unflanged (a pipe ending in free open space). The end impedance
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can also be user-defined and could represent modeled or experimental values for a

specific pipe configuration.

The wave speed ¢ in the pipe can be different from the speed of sound ¢,
in an open space. It then depends on the elastic properties of the pipe
structure. It is defined in Equation 5-4 in the Governing Equations

section.

[

The wave speed can be evaluated as sqrt (1/patd.invc2) or sqrt(1/
pafd.invc2) during the analysis and results stage.

CHAPTER 5:

END IMPEDANCE

Select an Impedance model.

For The Pipe Acoustics, Transient Interface select Infinite pipe (low Mach number limit)
(the default) or User defined. The Infinite pipe (low Mach number limit) models and
infinite pipe by specifying the characteristic impedance at that point. This condition
creates a non-reflecting boundary. The expression is valid for small values of the Mach
number

Ma = ug/c. For User defined enter an End impedance Z, 4 (SI unit: Pa-s/m). The
default is patd.rho*(sqrt(1/patd.invc2)) which is p-c.

For The Pipe Acoustics, Frequency Domain Interface select from the following—
Infinite pipe (low Mach number limit) (the default), Infinite pipe, Flanged pipe, circular,
Flanged pipe, rectangular, Unflanged pipe, circular (low ka limit), Unflanged pipe, circular,

or User defined.

¢ For Infinite pipe enter a Wave number % (SI unit: rad/m). The default expression is
pafd.omega* (sqrt(pafd.invc2)). This end impedance models the infinite pipe
using the full (nonlinear) dispersion relation. It is valid for all Mach numbers but

require the additional input of the wave number k.

* For Flanged pipe, circular enter an Inner radius a (SI unit: m). The default expression
is pafd.dh/2. This end impedance models the radiation impedance of a circular
pipe terminated in an infinite baffle. It is an exact analytical result valid for all
frequencies and pipe radii. In the low frequency limit it reduces to the classical

results:

chd = pc(%(ka)z + 1(08216 . ka))
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 For Flanged pipe, rectangular enter an Inner width w; (SI unit: m). The defaultis 5 cm
(0.005 m). Also enter an Inner height A; (ST unit: m). The defaultis 10 cm (0.01 m).
This end impedance models the radiation impedance of a pipe of rectangular cross
section terminated in an infinite baffle. The model is only valid in the low frequency

range where Rw. «1 and kA, « 1.

* For Unflanged pipe, circular (low ka limit) or Unflanged pipe, circular enter an Inner
radius @ (SI unit: m). The default expression is pafd.dh/2. These two end
impedance models prescribe the radiation impedance of an unflanged circular pipe
(a pipe ending in free open space). The first model is the classical low frequency
approximation valid for Za « 1. While the second model extends the frequency
range to ka < 3.83.

¢ For User defined enter an End impedance Z 4 (SI unit: Pa-s/m). The default
expression is pafd.rho*(sqrt(1/pafd.invc2)) which is p-c.

For a detailed review of the end impedance models see: Theory for the
.& Pipe Acoustics Boundary Conditions.
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Theory for the Pipe Acoustics
Interfaces

CHAPTER 5:

The equations governing the propagation of sound in pipes stem from considering
momentum, mass, and energy balances for a control volume of a piece of pipe. The
resulting equations are expressed in the cross-sectional averaged variables and reduces
the equations to a 1D component with scalar dependent variables. The present theory
assumes no thermal conduction and thus no losses due to thermal conduction
(isentropic sound propagation). The Pipe Acoustics, Transient and the Pipe Acoustics,
Frequency Domain interfaces require both the Pipe Flow Module and the Acoustics
Module.

In this section:

* Governing Equations

e Theory for the Pipe Acoustics Boundary Conditions
¢ Solving Transient Problems

e Cut-off Frequency

* Flow Profile Correction Factor b

* References for the Pipe Acoustics Interfaces

Governing Equations

The continuity equation derived for a control volume is given by

f’(—‘a“tP—hv(Apu) =0 (5-1)

and the corresponding momentum balance equation is

I £u)+V(pA|3u2) = _AVp+1,Z+AF (5-2)
where Z is the inner circumference of the pipe and A = A(x,p,...) is the inner wetted

cross-sectional area, u is the area-averaged mean velocity, which is also defined in the
tangential direction u = uey, p is the mean pressure along the pipe, T, is the wall drag

force, and F is a volume force. The gradient is taken in the tangential direction e;. The
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term B is a flow profile correction factor relating the mean of the squared total velocity

to the square of the mean velocity. Such that
1r~ 1~ 1(r~2 2
u=31u-dA  p=1ifpaa = (un dA))/u (5-3)
where

1; = z;(x) and u = ZL(X)

are the local non-averaged parameters. Again p and u are the area-averaged dependent

variables.

LINEARIZATION

The governing equations are now linearized, that is, all variables are expanded to first
order assuming stationary zero (Oth) order values (steady-state background
properties). The acoustic variations of the dependent variables are assumed small and

on top of the background values. This is done according to the following scheme:
u(x,t) = up(x) +uq(x,?)
p(x,t) = po(x) +py(x,¢)
p(xa t) = po(x) + pl(xa t)
A(x,t) = Ag(x) +Aq(x, 1)
where A is often only function of x; however, Ay can be changed by external factors
such as heating or structural deformation, thus the time dependency. The 1st order

terms represent small perturbations on top of the background values (Oth order). They

are valid for

2
p1 « pO p1 « pOCO |u1| « co A1 « AO

Moreover, the perturbations for the fluid density and cross-sectional area are expanded
to first order in pg in a Taylor series such that

P1=P—Po = (P—Po)[gﬂ

Slo

1o
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where the subscript s refers to constant entropy; that is, the processes are isentropic.

The relations for the fluid compressibility and the cross-sectional area compressibility

are
o= k= Lo L[2e]| 11
0" K, K, poaps0 pch
pa= L1247 | - L
A7 A, apso K,

Here, By is the fluid compressibility at the given reference pressure pg, the isentropic
bulk speed of sound is denoted cg, and py is the fluid density at the given reference
temperature and reference pressure. B is the effective compressibility of the pipe’s
cross-sectional A due to changes in the inner fluid pressure. The bulk modulus K is

equal to one over the compressibility.

Inserting the above expansions into the governing equations (Equation 5-1 and
Equation 5-2) and retaining only Ist-order terms yield the pipe acoustics equations
including background flow. These are:

19p u
A0—28—;+V.[A0p0[u1+—02p1D =0
c PoC
Ju u, dp u?
1 0 9P 0
p —_— = +V(A B—pq+2psA,Bu uj
vo[ A atj 0P 73P1* 2PooPtot (5-4)
+A0(Vp1+p1|3AVp0)+rWZ +AF =0

1 1 1 1 Po
= = PoBo+tBa) =pPolz+7) = 5+%
2 0tFo™ PA O(KO KA) C? K,

where c is the effective speed of sound in the pipe (it includes the effect due to the
elastic properties of the pipe defined through Ky ). The bulk modulus for the
cross-sectional area K is given by the pipe material properties according to the
so-called Korteweg formula (see Ref. 2). For a system with rigid pipe walls ¢; = ¢ as Kp
tends to infinity.

Using the fact that the velocity is taken along the tangential direction ey the governing
equations are rewritten in terms of the scalar values # and p and projected onto the
tangent. The 0 subscript is dropped on the density and area and the 1 subscript is also
dropped on the dependent variables.
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10 u
A—Egg + V{Ap(u + ——-%pD e, =0
c pc

2

du Yo dp %o

pA(—é—E + ;'E'é—j Vt(AB?p + ZPABUOUJ "€ (5-5)
+A(Vp+pBuVpo) € +1,Z+AF-e) =0

= p(By+By) = p(,é +,—§;) - Z+f<PZ

1

C s

where V., is the tangential derivative, Ty, is the tangential wall drag force (SI unit: N/

m2) and F is a volume force (ST unit: N/ms).

GOVERNING EQUATIONS

Pipe Acoustics, Transient Interface
Finally, the expression for the time derivative of the pressure in the momentum
equation is replaced by spatial derivatives using the continuity equation. This yields the

equations solved in the Pipe Acoustics, Transient interface:

1., vlap|lu+2p|| e =0
28 pC

2
u

pA%Zi +V (AB——p + ZpABuOUJ e+ uOVt(Ap[u + ‘"OépD "€ (5-6)
pC

+A(Vp+pBaVpy -e+17,Z+A(F-e) =0

= P(Bo"‘BA) = P(I; +kl;) = “‘"’K‘R‘A
c

1

C s

Pipe Acoustics, Frequency Domain Interface

In the frequency domain all variables are assumed to be time harmonic such that

1013

D zS(X)e' 5-7)
u = u(x)emt

inserting this into the governing Equation 5-6 (and dropping the tilde) yields the
equations solved in the Pipe Acoustics, Frequency Domain interface:
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u
im%p + Vt(Ap[u + ——%pD e, =0
c pc

2
. u u
iopAu + Vt(AB;-;—’p + ZpABuouj e, + uOVt(Ap(u + ;;%p]} e, (5-8)
+A(Vp+pBsVpy -e+7,Z+AF-e) =0
1 1 1 1 p
5= PBorba) =Pl r) = 5t
2 0" FA (KO KA) 2 Ku

¢ s

where ® = 2nf is the angular frequency and f'is the frequency.
Theory for the Pipe Acoustics Boundary Conditions

PRESSURE, OPEN, AND CLOSED CONDITIONS
The simplest boundary conditions to specify are to prescribe the pressure or the

velocity at the pipe ends. These result in the Pressure condition
P = Pi,

and the Velocity condition

and can be set independently of each other leaving the other dependent variable free.

A special subclass of the velocity condition is the Closed condition where
u=0

this corresponds to the sound-hard wall condition in pressure acoustics. It is also

assumed here that ug = 0 at a closed boundary.

END IMPEDANCE CONDITION
At the end of pipes the relation between the pressure and the velocity can be defined
in terms of an end impedance Zg,4. The End Impedance condition is in the Pipe

Acoustics interface given by

Alpu+2p| = alpt 120 59
put—=p| =APpy;—+5p (5-9)
Cc end ¢
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where Zopq = p/u (ST unit: (Pa-s)/m). Different models for the end impedance exist
in the Pipe Acoustics interfaces. The variety depend on if the transient or the frequency

domain equations are solved.

Transient End-Impedance Models

In the transient version of the physics interface the end impedance can be user-defined
or set to mimic an infinite long pipe for low Mach number background flow
conditions. In this case it is assumed that the pipe continues with constant cross section
A and that there is no external body force F and drag 1y, Because the acoustic waves
are, by design, always normal to the pipe ends. In order to define the relation between
the pressure and the velocity (the impedance) the dispersion relation for a plane wave
needs to be determined.

In order to do so insert the assumed plane wave form
p = Re(pel(mt —kx)
Re(ue

)
)

(ot —kx)

into the governing Equation 5-6 and solve for the desired relations. After some

manipulation this results in

with the dispersion relation

$-bn s cfo-o( () e

This dispersion relation is nonlinear in &. In the limit where B tends to zero and for
small Mach numbers M (= u/c) the expression is expanded to

2=puy + o1+ Jpp-1(%2))

Hence, the infinite pipe (low Mach number limit) end impedance relation reads

1

end

> = C%%[(B—l)uo + c(l+%ﬁ(ﬁ—1)(?}2ﬂ (5-11)

where the sign in front of ¢ depends on the direction of propagation of the wave.

THEORY FOR THE PIPE ACOUSTICS INTERFACES |

113



14 |

Frequency Domain End-Impedance Models

In the frequency domain many engineering relations exist for the end impedance or
radiation impedance of a pipe or waveguide. Most of the relations apply only to a
specific geometry or frequency range. The relations available in the Pipe Acoustics,

Frequency Domain interface are:

o Infinite pipe (low Mach number limit): This is the same relation as for the
transient study and the end impedance is given by Equation 5-11. This can be

thought of as the characteristic impedance of the tube.

e Infinite pipe: This relation uses the full dispersion relation given in Equation 5-10

and yields the expression

1

end

11 ug)? 1
A= C—QE{(B- Duy + CJB(B— 1)(7) +(1—EBAVpO)} (5-12)
where the wave number % at the right hand side is a user input. In the frequency

domain a good estimate for this quantity is simply w/c.

e Flanged pipe, circular: In the case of a circular pipe terminated in an infinite baffle
(a flanged pipe) an analytical expression exists for the radiation impedance (see
Ref. 1),

2J(2ka) _2H1(2ka))

Zopg = pe(1- 22412 (5-13)

where Jq is the Bessel function of order 1, Hj is the Struve function of order 1, a is
the pipe radius, and £ is the wave number. The Struve function is approximated

according to Ref. 3 by

Hyw) =2 - Jox) + (8- 5) 82, (19 39) 1o cosx (5-14)
T T x T 22
In the low frequency limit (small ka) Equation 5-13 reduces to the classical

expression for the radiation impedance
chd = pc(%(ka)z + L(0,8216 . ka)) (5_15)

e Flanged pipe, rectangular: In the case of a pipe of rectangular cross-section (with
sides w; and h;) terminated in an infinite baffle (a flanged pipe) the radiation

impedance can be approximated by
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Zos = BB +ikwn)* () kw1, kbl

(5-16)
-1 - _ _ . _1.3/2
f(x) = 2% Zsinh Lt 4 26 Zsinh i + §x3/2 + gx 82 _ %(x +x 1)

see Ref. 4 and Ref. 5.

o Unflanged pipe, civcular (low ka limit): In the case of a circular pipe of radius a
ending in free air the classical low ka limit for the radiation impedance is given by

Zeng = pe(3(ka)® +i(06133 ka)) ka1 (5-17)

see Ref. 1 and Ref. 5.

* Unflanged pipe, circular: A solution for the unflanged pipe exists for the case
whenka « 3,83 = 1,227, it is presented in Ref. 6 and is based on solving the
Wiener-Hopf integral, it reads

cl+R
PI”R

R = e—(ka)2/2(1+ %(ka)‘*[ln((w}— +%)D y= Q05712 4 g (5-18)

R| = A/nkae*’“’[ui 1 ) 1<ha<3,83
32 g

2ikad

Zoq = R = |Rle

where 8 is an interpolation function found by numerical integration for ka = 0,
6=0.6133.

Common for the last four radiation impedance relations is that they do only apply

when there is no background flow present ug = 0 (or at least when it is very small).

Solving Transient Problems

When solving transient acoustic problems where the wave shape is not necessarily
harmonic it might be necessary to resolve its spatial variations with a fine mesh, say
with a minimal scale dx. Now, in order for the numerical solution of the temporal
development of the acoustic field to be good it is necessary to restrict the maximal time
steps dt taken by the solver. The condition is known as the CFL condition (Courant—

Friedrichs-Lewy condition). For transient acoustic problems it is defined as

dt
C—C-%
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where C is the Courant number, and c¢ is the velocity.

For applications where all the shape functions are quadratic the Courant number
should be around 0.2. This condition restricts any acoustic disturbances to propagate
more than 20% of the mesh size dx during one time step d¢. In the Pipe Acoustics
interface where a mixed formulation exists, with linear elements for the pressure and
quadratic elements for the velocity, the condition might have to be tightened such that
C<0.2.

For an example where the CFL condition is used see Water Hammer:
il Application Library path Pipe_Flow_Module/Verification_Examples/

water_hammer_verification.

CHAPTER 5:

Cut-off Frequency

The Pipe Acoustics interface assumes plane wave propagation. This means that it
cannot model the propagation of the higher order modes that can propagate above
their cut-off frequency f°. In a rectangular pipe of cross section width w; and height h;
the cut-off frequency is

S R

In a pipe of circular cross section (with radius @) the cut-off frequency is

o ¢
flCTln = L

21a

where o'y, is the n’th zero of the differential of the Bessel function J”,(x) or order
m. The first few values are o'g1 = 0, at'gg = 3.83, a¢'11 = 1.84, and at'91 = 3.05 (see
Ref. 1 and Ref. 5 for further details).

Flow Profile Correction Factor 3

The flow profile correction factor § accounts for the ratio of the integrated local square
velocity field to the square of the integrated local velocity field (see Equation 5-3). It

is defined in terms of the total velocity field (background plus acoustic variations).

In the case of no-background flow (ug = 0) B is 1 in the absence of a wall drag

coefficient, as only plane wave modes propagate. If a wall drag force is introduced, to
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model some loss mechanism, 3 starts to differ slightly from 1. This can for example be

losses introduced to model viscous and thermal effects in narrow pipes.

In the presence of a background u the factor 3 can be set different 1 in order to model
a non-flat velocity profile inside the tube. The value of b (and the actual shape of the
background field) influences the convective momentum transfer balances. The places
where B enter the governing equations are multiplied with either the Mach number or
the Mach number squared, indicating that the effects become important for an

increasing background flow.

References for the Pipe Acoustics Interfaces
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